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UTILIZAREA EDITORULUI PENTRU AUTOMATE DE STARE
STATECAD

1. Scopul lucrării

Lucrarea prezintă principalele aspecte legate de utilizarea editorului pentru automate de stare
StateCAD, care permite specificarea sub formă grafică a automatelor de stare în cadrul sistemului
CAD Xilinx WebPACK. Lucrarea descrie de asemenea utilizarea programului StateBench, care per-
mite verificarea funcţionării automatelor descrise cu ajutorul editorului StateCAD. Se prezintă apoi un
exemplu de proiectare utilizând programele StateCAD şi StateBench.

2. Consideraţii teoretice

2.1. Prezentare generală

StateCAD este un modul integrat în sistemul de proiectare Xilinx WebPACK care permite
crearea şi editarea sub formă grafică a automatelor cu stări finite. Acest modul permite definirea stări-
lor, a semnalelor de ieşire care trebuie activate în fiecare stare (acţiunile stărilor) şi a tranziţiilor dintre
stări. Acţiunile stărilor şi condiţiile tranziţiilor pot fi specificate prin ecuaţii cu o sintaxă simplă, fără a
fi necesară cunoaşterea limbajelor de descriere hardware. Modulul StateCAD permite şi adăugarea la
automatele de stare create a unor circuite logice uzuale, ca porţi logice, multiplexoare, sumatoare,
comparatoare, bistabile, registre de deplasare şi numărătoare.

StateCAD permite validarea diagramelor de stare înainte de simularea funcţionării acestora.
Proiectantul poate descoperi condiţii nedeterminate, erori de sintaxă şi porţiuni specificate incomplet
din cadrul diagramelor de stare. După validarea unei diagrame, aceasta poate fi compilată în codul
echivalent într-un limbaj de descriere hardware (VHDL, Verilog sau ABEL). Codul obţinut poate fi
utilizat ulterior pentru simularea automatului de stare, pentru sinteza şi implementarea automatului,
sau pentru crearea unui simbol (macro) din automatul de stare, care poate fi plasat apoi într-o schemă.

După crearea şi validarea unui automat de stare, se poate verifica funcţionarea acestuia utili-
zând programul StateBench. Acest program permite crearea unui banc de test pentru automatul care
trebuie testat, prin specificarea semnalelor de intrare ale automatului şi a semnalelor de ieşire care tre-
buie generate în fiecare stare. StateBench utilizează bancul de test creat pentru simularea funcţionării
automatului, indicând diferenţele faţă de rezultatele aşteptate. După simulare, se poate genera un banc
de test care conţine constrângeri de timp. Acest banc de test se poate utiliza pentru verificarea con-
strângerilor de timp după sinteza automatului.

2.2. Definirea variabilelor şi constantelor

Pentru definirea automatelor de stare, trebuie să se asigneze un nume fiecărei stări şi trebuie să
se specifice valorile semnalelor de ieşire în fiecare stare. Pentru aceasta se utilizează variabile şi con-
stante. Operatorii sunt de asemenea utili pentru definirea unor ecuaţii mai complexe care definesc va-
lorile semnalelor de ieşire. Operatorii recunoscuţi sunt prezentaţi în secţiunea 2.5.3, în care este descri-
să sintaxa ecuaţiilor.

Numele variabilelor recunoscute de editorul StateCAD trebuie să respecte următoarele cerinţe:
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• Numele variabilelor trebuie să înceapă cu un caracter alfabetic (A..Z, a..z).

• Următoarele caractere pot fi caractere alfanumerice (A..Z, a..z, 0..9) şi caracterul de subliniere
(_). Nu sunt admise două caractere de subliniere consecutive.

• Ultimul caracter nu poate fi caracterul de subliniere.

• Cuvintele rezervate nu pot fi utilizate ca nume de variabile.

• Nu se diferenţiază între ele literele mici şi cele mari.

• Numele semnalelor de tip bit pot avea o lungime de până la 16 caractere, iar numele vectorilor
pot avea o lungime de până la 14 caractere.

Constantele pot fi utilizate pentru iniţializarea semnalelor sau pentru compararea valorii vecto-
rilor. Aceste constante pot fi definite în baza 2, 8, 10 sau 16. Baza implicită este cea zecimală. Con-
stantele sunt definite prin valori numerice precedate opţional de un specificator al bazei, care începe cu
caracterul ^. Constantele binare de un singur bit pot fi specificate şi prin includerea lor între ghilimele
simple, iar constantele binare de mai mulţi biţi pot fi specificate şi prin includerea lor între ghilimele
duble. Tabelul 9.1 indică specificatorii bazelor de numeraţie şi exemple de constante definite în dife-
rite baze.

Tabelul 9.1. Definirea constantelor recunoscute de editorul StateCAD.

Baza Specificator al bazei Exemple

Binară (2) ^b sau ^B ^b11110000, “11110000”, ‘1’, ‘0’

Octală (8) ^o sau ^O ^o360

Zecimală (10) ^d sau ^D ^d240, 240

Hexazecimală (16) ^h sau ^H ^hF0, ^hf0

Există două constante predefinite, TRUE şi FALSE, care pot fi utilizate pentru a indica faptul
că o condiţie este întotdeauna adevărată, respectiv falsă. Aceste constante pot fi utilizate în ecuaţii si-
milar altor constante sau variabile.

2.3. Crearea unui fişier pentru o diagramă de stare

Un fişier sursă care va conţine o nouă diagramă de stare poate fi creat din fereastra Project
Navigator a sistemului Xilinx WebPACK. Pentru aceasta, se execută următoarele operaţii:

1. Se selectează comanda Project → New Source.

2. În fereastra de dialog New, se selectează opţiunea State Diagram.

3. În câmpul File Name se introduce numele fişierului în care se va păstra diagrama de stare.

4. Se selectează butonul Next.

5. În fereastra de dialog New Source Information, se selectează butonul Finish.

Editorul StateCAD va fi lansat în execuţie într-o nouă fereastră (Figura 9.1).

Observaţii
• Numele fişierului introdus în câmpul File Name trebuie să înceapă cu un caracter alfabetic.

• Numele fişierului poate conţine până la opt caractere alfanumerice. Extensia fişierului va fi
adăugată în mod automat de către editor; extensia implicită este .dia.
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• Opţiunea Add to Project din fereastra de dialog New nu are efect în cazul creării diagramelor
de stare. Aceste diagrame nu pot fi adăugate în mod automat la proiectele create cu sistemul
WebPACK, fiind necesară adăugarea explicită a acestora cu comanda Project → Add Source.

Figura 9.1. Fereastra editorului pentru automate de stare StateCAD.

2.4. Crearea şi editarea automatelor de stare

2.4.1. Crearea unui automat de stare

Un automat de stare poate fi creat prin adăugarea stărilor automatului, specificarea acţiunilor
pentru fiecare stare (o acţiune reprezentând activarea unui semnal de ieşire) şi adăugarea tranziţiilor
între stări. Stările indică situaţia curentă în care se află automatul de stare. O stare este reprezentată de
către editorul StateCAD printr-un cerc sau o elipsă, în interiorul căreia se indică numele stării şi, sub
acest nume, semnalele de ieşire care sunt active în starea respectivă. Tranziţiile între stări sunt repre-
zentate prin săgeţi trasate între aceste stări.

Crearea unui nou automat de stare este simplificată prin utilizarea utilitarului State Machine
Wizard, care creează un schelet al automatului de stare. Acest automat conţine numărul de stări speci-
ficat de proiectant, stările având nume asignate în mod implicit. De asemenea, automatul conţine tran-
ziţiile între stări şi implementează logica de resetare specificată de proiectant. Ulterior, se pot edita
stările automatului, se pot adăuga noi stări sau tranziţii şi se pot specifica acţiunile care trebuie execu-
tate în fiecare stare.

Pentru crearea unui automat de stare cu ajutorul utilitarului State Machine Wizard, se proce-
dează astfel:

1. Se selectează butonul Draw State Machines . Se va deschide fereastra State Machine
Wizard (Figura 9.2).

2. În câmpul Shape of state machine din fereastra afişată se selectează forma sub care se va de-
sena diagrama de stare: pe o coloană (Column), pe două, trei sau patru coloane (Multi-
Column), pe linie (Row), sau ca o figură geometrică cu forma corespunzătoare numărului de
stări (Geometric). Forma selectată este vizualizată în câmpul Preview.
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3. În câmpul Number of States se selectează numărul de stări ale automatului.

Figura 9.2. Fereastra de dialog State Machine Wizard.

4. Se selectează butonul Next. Se va deschide fereastra de dialog Reset The State Machine (Figu-
ra 9.3).

Figura 9.3. Fereastra de dialog Reset The State Machine.

5. În câmpul Reset Mode al ferestrei afişate, se selectează modul în care se va genera logica de
resetare a automatului de stare. Acest mod poate fi asincron (Asynchronous), când automatul
se va reseta imediat ce semnalul de resetare devine activ, sau sincron (Synchronous), când au-
tomatul se va reseta la următorul front al semnalului de ceas după activarea semnalului de
resetare. Selectarea modului asincron poate fi avantajoasă pentru circuitele FPGA, care conţin
de obicei o logică eficientă pentru resetarea globală a circuitului în mod asincron.

6. Se selectează butonul Next. Se va deschide fereastra de dialog Setup Transitions (Figura 9.4).

Figura 9.4. Fereastra de dialog Setup Transitions.
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7. În câmpul Add Transitions se selectează tipul tranziţiilor care vor fi prezente în diagrama de
stare. În mod implicit, este selectată doar opţiunea Next, prin care diagrama va conţine tranziţii
de la fiecare stare la starea următoare a acesteia. Dacă se selectează şi opţiunea Loop back, di-
agrama va conţine şi tranziţii de buclare, prin care automatul va rămâne în aceeaşi stare dacă o
anumită condiţie nu este îndeplinită. Dacă se selectează şi opţiunea Previous, diagrama va
conţine şi tranziţii de la fiecare stare la starea precedentă a acesteia.

8. Se selectează butonul Finish. Se va afişa un dreptunghi cu conturul de culoare verde, care in-
dică marginile diagramei.

9. Se deplasează dreptunghiul în poziţia dorită din fereastra editorului şi se execută un clic cu
butonul din stânga. Se va afişa diagrama de stare în fereastra editorului StateCAD, în modul
ilustrat în Figura 9.5 pentru un automat cu patru stări pentru care s-a selectat forma ca o figură
geometrică.

Figura 9.5. Exemplu de diagramă creată cu utilitarul State Machine Wizard.

2.4.2. Adăugarea unor noi stări

Pentru adăugarea unor noi stări la un automat de stare creat anterior, se procedează astfel:

1. Se selectează butonul Draw States , aflat în partea stângă a ecranului.

2. Se deplasează cursorul în poziţia în care trebuie adăugat simbolul stării şi se execută un clic cu
butonul din stânga. StateCAD atribuie în mod implicit un nume noii stări, de exemplu,
STATE4.

3. Se editează starea pentru modificarea numelui stării şi specificarea semnalelor de ieşire care
trebuie activate în starea respectivă. Aceste operaţii sunt descrise în secţiunea următoare.

2.4.3. Editarea stărilor

După crearea unui automat de stare cu utilitarul State Machine Wizard sau adăugarea unor noi
stări, se pot modifica numele stărilor şi se pot asigna valorile semnalelor de ieşire care trebuie generate
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în stările respective (în cazul automatelor de tip Moore). Pentru aceasta, se poate utiliza fereastra de
dialog Edit State, în modul prezentat mai jos.

Numele fiecărei stări trebuie să fie un nume unic de variabilă. Atunci când asignarea stărilor
se realizează prin metoda cu un bistabil pe stare, numele stărilor se utilizează ca variabile de stare.

Editorul StateCAD asignează în mod automat valori implicite semnalelor de ieşire. Pentru ca
semnalele să aibă valorile corecte, trebuie să se specifice valorile semnalelor de ieşire în fiecare stare a
automatului. În cazul automatelor de tip Mealy, valorile semnalelor de ieşire se pot specifica la adău-
garea condiţiilor pentru tranziţiile între stări (secţiunea 2.4.5). Dacă anumite semnale de ieşire nu sunt
specificate în mod explicit într-o anumită stare (sau la tranziţiile în acea stare), valoarea care va fi atri-
buită semnalelor în starea respectivă depinde de modul în care este setată opţiunea de configuraţie
Retain Output Values. Această opţiune poate fi setată în secţiunea Options a ferestrei de dialog
Configuration, fereastră care poate fi deschisă prin comanda Options → Configuration. Valorile sem-
nalelor de ieşire care nu sunt specificate vor fi asignate de editorul StateCAD astfel:

• Dacă opţiunea Retain Output Values nu este activată, semnalele de ieşire care nu sunt specifi-
cate în mod explicit vor fi setate la valorile lor inactive.

• Dacă opţiunea Retain Output Values este activată, semnalele de ieşire care nu sunt specificate
în mod explicit îşi păstrează valorile de la ultima asignare, până la asignarea unei noi valori.

Editorul StateCAD permite specificarea valorii semnalelor de ieşire în mai multe moduri:

• Printr-o listă de semnale de tip bit. Semnalele din listă trebuie separate printr-un spaţiu. Sem-
nalele din listă vor fi activate în starea respectivă. Dacă un semnal este precedat de caracterul
'!', care indică complementul logic, semnalul va fi dezactivat. De exemplu, considerăm că se
specifică următoarea listă:

OUT_A !OUT_B

Presupunând că semnalele OUT_A şi OUT_B sunt active în starea '1' logic, semnalul OUT_A va
fi setat la valoarea '1', iar semnalul OUT_B va fi setat la valoarea '0'. Nivelul activ al semnale-
lor poate fi setat prin comanda Options → Variable, comandă care este descrisă în secţiunea
2.7.

• Prin asignarea unor valori constante. Se pot asigna valori constante atât semnalelor de tip bit,
cât şi vectorilor. Pentru asignare se poate utiliza fie caracterul '=', fie combinaţia de caractere
'<='. Asignările succesive trebuie separate între ele fie prin spaţii, fie prin caracterul ';'. În
exemplele următoare, OUT_A şi OUT_B sunt semnale de tip bit, iar VEC_A şi VEC_B sunt vec-
tori (magistrale):

OUT_A = '1'; OUT_B = '0'; VEC_A = 7; VEC_B = "1010";

• Prin ecuaţii. Ecuaţiile permit asignarea unor expresii booleene semnalelor de tip bit şi vecto-
rilor. Ecuaţiile pot conţine atât semnale de intrare sau de ieşire, cât şi variabile de stare. Ecua-
ţiile trebuie separate prin caracterul ';'. Două exemple de ecuaţii sunt prezentate în continuare:

OUT_A <= (IN_A OR IN_B) AND (NUM > 9); NUM <= NUM+1;

Editorul StateCAD permite specificarea unor ecuaţii complexe pentru semnalele de ieşire. De
exemplu, se pot introduce ecuaţiile unor multiplexoare, sumatoare sau numărătoare care trebuie acti-
vate într-o anumită stare. Pentru simplificarea introducerii acestor ecuaţii, se poate utiliza utilitarul
Logic Wizard, care poate fi invocat prin selectarea butonului Output Wizard din fereastra Edit State
(Figura 9.6). Utilitarul Logic Wizard este descris în secţiunea 2.5.2.

Pentru asignarea sau modificarea numelui unei stări şi a valorii semnalelor de ieşire în starea
respectivă, se procedează astfel:

1. Se execută un clic dublu pe cercul sau elipsa reprezentând starea care trebuie editată. Se va
afişa fereastra de dialog Edit State (Figura 9.6).
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Figura 9.6. Fereastra de dialog Edit State.

2. În câmpul State Name se introduce numele stării sau se modifică numele existent.

3. În câmpul Outputs se introduce lista semnalelor de ieşire care trebuie activate sau dezactivate
în starea respectivă, separate prin spaţii, sau se introduc ecuaţiile semnalelor de ieşire, separate
prin caracterul ';'.

4. Se selectează butonul OK. Ecuaţiile semnalelor de ieşire vor fi afişate sub numele stării, sepa-
rate de acest nume printr-o linie orizontală (Figura 9.7).

Figura 9.7. Simbolul stării STATE0 din Figura 9.5 după editarea acesteia.

2.4.4. Adăugarea tranziţiilor

Editorul StateCAD permite adăugarea simplă a tranziţiilor între stări. Tranziţiile pot fi repre-
zentate fie prin linii drepte, fie prin linii curbate. Fiecare linie de tranziţie este definită prin două
puncte reprezentând capetele liniei, şi alte două puncte de control, care permit curbarea liniei. Punctele
de capăt sunt reprezentate prin mici pătrate cu contururi de culoare neagră. Primul punct de control
este reprezentat printr-un pătrat cu conturul de culoare verde, iar al doilea punct de control este repre-
zentat printr-un pătrat cu conturul de culoare albastră.

Modul cel mai simplu pentru adăugarea unei tranziţii este prin trasarea unei linii drepte. În
acest caz, utilizatorul indică doar punctele de capăt, cele două puncte de control fiind plasate în mod
automat de către editorul StateCAD. Ulterior, linia dreaptă poate fi transformată într-o linie curbă prin
repoziţionarea punctelor de control. Pentru adăugarea unei tranziţii sub forma unei linii drepte, se pro-
cedează astfel:

1. Se selectează butonul Draw Transitions , aflat în partea stângă a ecranului.

2. Se selectează starea de la care trebuie efectuată tranziţia, executând un clic în interiorul stării
respective, iar apoi se execută un nou clic în interiorul stării, în apropierea marginii de la care
trebuie să pornească tranziţia. Va apare un pătrat de culoare roşie pe marginea simbolului stă-
rii, iar un alt pătrat va urmări deplasarea cursorului.

3. Se deplasează cursorul deasupra stării destinaţie. Va apare un pătrat de culoare roşie pe mar-
ginea simbolului stării şi o linie între cele două stări, sursă şi destinaţie. Se fixează poziţia
punctului de capăt al liniei şi se execută un clic în poziţia respectivă. Editorul va adăuga în
mod automat punctele de control pe linia de tranziţie.

Pentru adăugarea unei tranziţii sub forma unei linii curbe, se procedează astfel:
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1. Se selectează butonul Draw Transitions , aflat în partea stângă a ecranului.

2. Se selectează starea de la care trebuie efectuată tranziţia, iar apoi se execută un clic în interio-
rul stării, în apropierea marginii de la care trebuie să pornească tranziţia. Va apare un pătrat de
culoare roşie pe marginea simbolului stării, iar un alt pătrat va urmări deplasarea cursorului
(acesta va fi primul punct de control).

3. Se execută un clic în afara stării pentru a fixa poziţia primului punct de control. La capătul
cursorului se va ataşa al doilea punct de control.

4. Se fixează poziţia celui de-al doilea punct de control şi se execută un clic în acea poziţie. La
capătul cursorului se va ataşa al doilea punct de capăt.

5. Se deplasează cursorul deasupra stării destinaţie, se fixează poziţia punctului de capăt al liniei
şi se execută un clic în poziţia respectivă.

Pentru adăugarea unei tranziţii de buclare, care începe şi se termină în aceeaşi stare, se proce-
dează în felul următor:

1. Se selectează butonul Draw Transitions .

2. Se selectează starea pentru care trebuie adăugată tranziţia de buclare, iar apoi se execută un
clic dublu în apropierea marginii unde se doreşte să apară tranziţia. Editorul va adăuga linia
pentru tranziţia de buclare şi condiţia @ELSE pentru această tranziţie. Condiţia @ELSE este
descrisă în secţiunea următoare.
După adăugarea tranziţiilor dorite, se selectează butonul Select Objects  pentru a termina

adăugarea tranziţiilor.

2.4.5. Adăugarea condiţiilor pentru tranziţii

O condiţie a unei tranziţii determină executarea tranziţiei respective atunci când condiţia devi-
ne adevărată. Pentru adăugarea condiţiei care va determina executarea unei tranziţii, se execută un clic
dublu pe linia tranziţiei respective. Se va deschide fereastra de dialog Edit Condition (Figura 9.8).
Condiţia trebuie introdusă în câmpul Condition.

Figura 9.8. Fereastra de dialog Edit Condition.

O condiţie poate fi specificată fie ca o ecuaţie booleană, fie ca o expresie booleană care se
evaluează la valoarea TRUE sau FALSE. O ecuaţie booleană poate conţine semnale de intrare, sem-
nale de ieşire şi variabile logice. Erorile de sintaxă din ecuaţiile condiţiilor şi condiţiile nedeterminate
sunt detectate la compilarea diagramei de stare. Un exemplu simplu de condiţie specificată printr-o
expresie booleană constă dintr-un singur semnal de tip bit; condiţia va fi adevărată atunci când sem-
nalul este activ. Dacă semnalul este precedat de caracterul '!', condiţia va fi adevărată atunci când
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semnalul este inactiv. În Figura 9.9, tranziţia din starea A în starea B se efectuează atunci când sem-
nalul Xin devine activ. Alte expresii booleene simple constau din semnale conectate prin operatori lo-
gici.

Figura 9.9. Condiţii de tranziţie specificate prin expresii booleene constând dintr-un singur semnal.

În cazul automatelor de stare de tip Mealy, se pot specifica semnalele de ieşire care trebuie
activate pentru fiecare tranziţie. Ecuaţiile acestor semnale trebuie introduse în câmpul Outputs. Aceste
ecuaţii nu pot conţine variabile de stare sau variabile logice. Se pot defini însă ecuaţii complexe pentru
circuite logice cum sunt multiplexoare, registre sau numărătoare.

Există două condiţii speciale: condiţia adevărată în mod implicit şi condiţia ELSE. O tranziţie
căreia nu i se asociază nici o condiţie se execută întotdeauna, astfel încât condiţia unei asemenea tran-
ziţii este adevărată întotdeauna. Această condiţie este deci adevărată în mod implicit. O condiţie poate
fi specificată ca adevărată în mod explicit dacă pentru condiţia respectivă se indică valoarea TRUE.

Condiţia adevărată în mod implicit se utilizează atunci când automatul de stare trebuie să
efectueze tranziţii într-o anumită ordine care este independentă de semnalele de intrare. Un asemenea
automat de stare poate fi iniţializat totuşi cu un semnal de resetare. Atunci când condiţia de resetare
este adevărată, se execută tranziţia de resetare, care este mai prioritară decât condiţia adevărată în mod
implicit.

De multe ori, o stare poate avea mai multe tranziţii în alte stări, iar una din tranziţii trebuie
executată atunci când nici o condiţie a unei alte tranziţii nu este adevărată. Aceasta este tranziţia
ELSE, iar condiţia acestei tranziţii este numită condiţie ELSE. Condiţia ELSE este indicată printr-un
operator special, @ELSE. Tranziţia ELSE are prioritatea maximă dintre toate tranziţiile dintr-o stare.

Editorul StateCAD permite de asemenea condiţia implicită ELSE, care permite ca un automat
să rămână într-o anumită stare dacă nici una din condiţiile tranziţiilor din acea stare nu este adevărată.
Astfel, nu este necesară adăugarea unei tranziţii de buclare la starea respectivă, ceea ce simplifică dia-
gramele de stare. Această facilitate este activată în mod implicit, dar poate fi dezactivată prin deselec-
tarea opţiunii Implied Else din secţiunea Options a ferestrei de dialog Configuration (deschisă prin
comanda Options → Configuration).

2.4.6. Adăugarea condiţiei de resetare a automatului

Editorul StateCAD permite specificarea unei condiţii de resetare a automatului de stare.
Atunci când condiţia de resetare a automatului de stare devine adevărată, indiferent de starea în care se
află automatul, se execută tranziţia într-o stare de resetare specificată. Această stare este de obicei şi
starea iniţială a automatului. La tranziţia în starea de resetare, semnalele de ieşire vor fi setate la valo-
rile specificate pentru această stare. Pentru un automat de stare se poate specifica o condiţie de resetare
sincronă şi o condiţie de resetare asincronă.

La adăugarea unei condiţii de resetare, trebuie să se specifice dacă resetarea este sincronă sau
asincronă. După selectarea modului de resetare, editorul StateCAD setează în mod automat ca şi con-
diţie de resetare ultima condiţie utilizată pentru o resetare cu acelaşi mod. Pentru modificarea condiţi-
ei, se execută un clic dublu pe condiţia respectivă şi se editează.

La compilarea automatului de stare, se execută operaţia ŞI logic între complementul logic al
condiţiei de resetare sincronă şi fiecare din condiţiile de tranziţie ale automatului de stare. Deci, com-
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plementul logic al condiţiei de resetare este implicit pentru fiecare tranziţie şi nu trebuie adăugat ma-
nual.

Pentru adăugarea condiţiei de resetare a automatului, se execută următoarele operaţii:

1. Se selectează butonul Draw Reset , aflat în partea stângă a ecranului.

2. Se execută un clic în apropierea stării în care trebuie realizată tranziţia la resetarea automatu-
lui. Va apare punctul de început al liniei de tranziţie, iar primul punct de control va fi ataşat la
cursor.

3. Se continuă în acelaşi mod ca şi la adăugarea unei tranziţii obişnuite, fie sub forma unei linii
drepte, fie sub forma unei linii curbe (secţiunea 2.4.4).

4. După terminarea adăugării tranziţiei de resetare, se va afişa un mesaj pentru specificarea mo-
dului de resetare. Se selectează butonul Yes dacă se doreşte o resetare asincronă, sau butonul
No dacă se doreşte o resetare sincronă. Condiţia de resetare va fi adăugată automat pe baza ul-
timei condiţii utilizate.

5. Se selectează butonul Select Objects  pentru a termina adăugarea tranziţiei de resetare.

6. Dacă este necesar, se modifică condiţia de resetare adăugată automat de editorul StateCAD.
Pentru aceasta, se execută un clic dublu pe condiţia de resetare, iar în fereastra Edit Condition
se editează condiţia în câmpul Condition. În câmpul Mode al aceleiaşi ferestre (câmp aflat în
colţul din dreapta jos) se poate modifica şi modul de resetare prin selectarea uneia din opţiu-
nile Asynchronous sau Synchronous.

Observaţie
Pentru a fi posibilă sinteza unui automat cu resetare asincronă, circuitul programabil care va fi
utilizat pentru implementare trebuie să dispună de semnale de resetare asincronă. În caz con-
trar, sinteza nu va putea fi executată. În acest caz, trebuie să se utilizeze resetarea sincronă.
Circuitele FPGA Xilinx dispun de semnale globale de setare şi resetare asincronă.

2.5. Adăugarea unor circuite logice suplimentare

2.5.1. Utilizarea circuitelor logice

Utilizarea diagramelor de stare este avantajoasă în special pentru proiectarea blocurilor de
control ale sistemelor digitale în general şi ale automatelor de stare în particular. Pe lângă aceste blo-
curi, sistemele digitale necesită circuite logice suplimentare pentru implementarea funcţiilor de ieşire
şi a unor elemente de prelucrare care nu pot fi specificate în mod simplu cu ajutorul diagramelor de
stare. De aceea, este utilă completarea diagramelor de stare cu descrierea prin alte metode a circuitelor
logice suplimentare necesare pentru proiectarea unor sisteme digitale complexe.

Editorul pentru automate de stare StateCAD permite adăugarea unor circuite logice supli-
mentare la sistemul digital proiectat. Aceste circuite sunt adăugate sub forma unor blocuri logice
combinaţionale sau secvenţiale, care pot fi descrise prin ecuaţii cu o sintaxă relativ simplă. Pentru
simplificarea definirii ecuaţiilor care descriu funcţionarea circuitelor logice adăugate, există un utilitar
numit Logic Wizard. Cu ajutorul acestuia se pot adăuga în mod simplu circuite combinaţionale sau
secvenţiale dintr-un set predefinit, cum sunt: porţi logice, multiplexoare, sumatoare, comparatoare,
bistabile, registre, numărătoare, registre de deplasare. Unele din aceste circuite sunt definite doar pen-
tru semnale de tip bit, iar altele pot fi configurate cu ajutorul utilitarului Logic Wizard atât pentru sem-
nale de tip bit, cât şi pentru vectori. Acest utilitar defineşte în mod automat ecuaţiile circuitelor care au
fost configurate de proiectant. Circuitele adăugate la sistemul digital pot fi reprezentate fie sub formă
grafică, fie sub formă de text, prin ecuaţiile lor.

Proiectantul poate edita ecuaţiile circuitelor predefinite pentru modificarea funcţiei circuitelor,
sau poate defini noi circuite prin specificarea ecuaţiilor acestora. Aceste ecuaţii pot conţine operatori
logici pentru definirea unor elemente combinaţionale utilizate în mod frecvent pentru generarea sem-
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nalelor de intrare ale automatelor de stare, cum sunt decodificatoarele de adresă. De asemenea, ecuaţi-
ile pot conţine nume de stări sau variabile de stare, ceea ce permite specificarea unor circuite comple-
xe într-o formă concisă. La compilarea ecuaţiilor logice care conţin numele unor stări, aceste nume
sunt înlocuite cu asignarea stărilor respective.

La editarea unei ecuaţii logice, există posibilitatea specificării unui semnal care, atunci când
este activat, va determina trecerea semnalului descris prin ecuaţia respectivă în starea de înaltă impe-
danţă. Circuitele secvenţiale descrise prin ecuaţiile logice pot fi resetate în mod sincron sau asincron.

2.5.2. Adăugarea circuitelor logice cu utilitarul Logic Wizard

Utilitarul Logic Wizard permite adăugarea simplă a unor circuite logice combinaţionale şi sec-
venţiale uzuale. Acest utilitar permite proiectantului selectarea dintr-un set de circuite predefinite a
circuitului care trebuie adăugat, iar apoi parametrizarea circuitului prin indicarea numelui semnalelor
de intrare şi de ieşire ale acestuia, a tipului semnalelor (biţi sau vectori) şi a dimensiunii semnalelor
care sunt vectori. Pe baza setărilor proiectantului, utilitarul generează în mod automat ecuaţiile circui-
tului, defineşte porturile de I/E ale acestuia şi adaugă semnalele de control necesare funcţionării circu-
itului.

Pentru adăugarea unui circuit cu ajutorul utilitarului Logic Wizard, se execută următoarele
operaţii:

1. Se selectează butonul Random Logic  aflat în partea de sus a ecranului sau butonul Lo-

gic Wizard  aflat în partea stângă a ecranului.

2. Se deplasează cursorul deasupra unei zone libere de pe ecran şi se execută un clic cu butonul
din stânga. Se va deschide fereastra de dialog Logic Wizard.

3. Se selectează tipul circuitului care trebuie adăugat din lista afişată în partea din stânga sus a
ferestrei. Conţinutul ferestrei se va actualiza în funcţie de circuitul selectat. Astfel, în zona
centrală a ferestrei se afişează simbolul grafic al circuitului selectat, iar în partea din dreapta
sus a ferestrei se afişează descrierea textuală a circuitului. Figura 9.10 ilustrează fereastra Lo-
gic Wizard în care s-a selectat un registru de deplasare la stânga (circuitul Shift Left).

Figura 9.10. Fereastra de dialog Logic Wizard.

4. În partea din stânga simbolului grafic al circuitului se completează numele semnalului sau al
semnalelor de intrare ale circuitului. În Figura 9.10, numele semnalului de intrare se introduce
în câmpul DIN.

5. În partea din dreapta simbolului grafic al circuitului se completează numele semnalului de ie-
şire al circuitului. În Figura 9.10, numele semnalului de ieşire se introduce în câmpul DOUT.
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6. În câmpul Data path width se selectează dimensiunea semnalelor de intrare şi/sau de ieşire ca-
re sunt vectori. Această dimensiune poate fi de până la 32 de biţi. Unele circuite sunt disponi-
bile doar pentru semnale de tip bit, iar la acestea dimensiunea semnalelor este setată la 1 şi nu
poate fi modificată.

7. Se selectează tipul semnalului de ieşire. Dacă opţiunea Registered nu este selectată, semnalul
de ieşire va fi combinaţional, iar dacă această opţiune este selectată, semnalul de ieşire va fi
secvenţial. Valoarea unui semnal de ieşire combinaţional se modifică imediat ce se modifică
semnalele de intrare de care depinde semnalul de ieşire. Valoarea unui semnal de ieşire sec-
venţial se modifică doar la apariţia unui front al semnalului de ceas, după modificarea semna-
lelor de intrare de care depinde semnalul de ieşire. Există cazuri tipice când semnalul de ieşire
este combinaţional (de exemplu, în cazul multiplexoarelor), şi altele când semnalul de ieşire
este secvenţial (de exemplu, în cazul numărătoarelor).

8. Se selectează butonul OK. Utilitarul Logic Wizard verifică validitatea numelor semnalelor,
generează ecuaţia logică a circuitului şi defineşte vectorii noi care au fost specificaţi. Se va
deschide apoi fereastra de dialog Edit Equation (Figura 9.11).

Figura 9.11. Fereastra de dialog Edit Equation.

9. În fereastra Edit Equation se poate edita ecuaţia logică generată. În câmpul Name se afişează
numele semnalului de ieşire al circuitului care a fost specificat în fereastra Logic Wizard. În
Figura 9.11, acest nume este DOUT. În câmpul Width apare dimensiunea semnalului, iar în
câmpul Expression se afişează ecuaţia semnalului din câmpul Name. Tipul semnalului
(combinaţional sau secvenţial) se afişează în câmpul Type. În mod normal, nu este necesar să
se modifice conţinutul acestor câmpuri. Dacă se doreşte modificarea funcţiei circuitului, tre-
buie să se modifice ecuaţia acestuia care a fost generată în mod automat. Sintaxa ecuaţiilor lo-
gice este descrisă în secţiunea următoare.

10. Opţional, în câmpul Hi-Z se poate introduce numele unui semnal de control care, atunci când
este activ, determină trecerea semnalului de ieşire al circuitului în starea de înaltă impedanţă.
În caseta alăturată se selectează nivelul activ al semnalului de control (1 sau 0).

11. În câmpurile Sync reset şi Async reset se pot introduce numele unor semnale pentru resetarea
sincronă, respectiv asincronă a circuitului. În casetele alăturate se specifică nivelul activ al
semnalului de resetare respectiv (1 sau 0).

12. Se selectează butonul Close pentru închiderea ferestrei Edit Equation. Dacă ecuaţia din câm-
pul Expression nu a fost modificată, simbolul grafic al circuitului va fi afişat pe ecran (Figura
9.12).

13. Se selectează butonul Select Objects  dacă nu mai trebuie adăugate alte circuite.
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Figura 9.12. Simbolul unui registru de deplasare la stânga de 4 biţi generat cu utilitarul Logic Wizard.

Observaţie
Utilitarul Logic Wizard poate fi invocat şi la editarea stărilor pentru introducerea semnalelor
de ieşire activate într-o anumită stare (la automatele de tip Moore) sau la adăugarea condiţiilor
pentru tranziţii pentru introducerea semnalelor de ieşire activate la efectuarea unei anumite
tranziţii (la automatele de tip Mealy). Pentru acesta, se selectează butonul Output Wizard în
fereastra Edit State, respectiv Edit Condition. Circuitele necesare pentru generarea acestor
semnale nu vor fi afişate în mod explicit pe ecran.

Circuitele logice adăugate cu utilitarul Logic Wizard sunt afişate pe ecran fie sub formă grafi-
că, fie sub formă textuală. În mod implicit, circuitele sunt afişate sub formă grafică. Modul de afişare
se poate modifica prin comanda View → Show Logic Graphics. Dacă opţiunea de afişare sub formă
grafică este dezactivată, fiecare circuit este reprezentat printr-o casetă conţinând ecuaţia circuitului
respectiv. Circuitele ale căror ecuaţii au fost modificate de proiectant vor fi afişate întotdeauna sub
formă textuală.

Pentru editarea ecuaţiei unui circuit adăugat anterior, se selectează reprezentarea circuitului
(fie cea grafică, fie cea textuală) şi se execută un clic în interiorul dreptunghiului selectat. Va apare
fereastra Edit Equation, care permite editarea ecuaţiei circuitului.

2.5.3. Ecuaţii şi operatori

Ecuaţiile se utilizează pentru specificarea unor condiţii şi pentru descrierea funcţionării unor
circuite logice diferite de cele care pot fi adăugate cu utilitarul Logic Wizard. Ecuaţiile pot conţine va-
riabile (de tip bit sau vectori), constante şi operatori. Dacă o ecuaţie conţine variabile de tip bit şi vec-
tori, variabilele de tip bit sunt expandaţi automat în vectori cu dimensiunea corespunzătoare vectorului
destinaţie. Precedenţa operatorilor trebuie indicată prin utilizarea parantezelor.

Operatorii pot fi grupaţi în următoarele categorii:

• Operatori logici (booleeni);
• Operatori de comparaţie;
• Operatori de adunare şi scădere;
• Operatorul de specificare a domeniului;
• Operatorul de concatenare.

Operatorii logici permit efectuarea unor operaţii booleene între două variabile de tip bit sau
între poziţiile binare de acelaşi rang a doi vectori. Un bit individual al unui vector este indicat prin
adăugarea numărului bitului la numele vectorului. De exemplu, ADR15 indică bitul 15 al vectorului
ADR. Operatorii logici sunt prezentaţi în Tabelul 9.2.

Tabelul 9.2. Operatori logici.

Operator Semnificaţie

# sau | sau OR SAU logic

& sau AND ŞI logic

! sau NOT Complement logic
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Operatorii de comparaţie permit compararea variabilelor de tip bit sau a vectorilor cu con-
stante. Rezultatele comparaţiilor sunt valori booleene (TRUE sau FALSE), care pot fi combinate prin
operatori logici pentru a forma condiţii mai complexe. Operatorii de comparaţie au o precedenţă mai
ridicată decât operatorii logici SAU, ŞI. La combinarea operaţiilor de comparaţie prin operatori logici,
comparaţiile trebuie incluse în paranteze, ca în exemplul următor:

(V > 9) & (V < 16)

Tabelul 9.3 prezintă operatorii de comparaţie.

Tabelul 9.3. Operatori de comparaţie.

Operator Semnificaţie

= sau == Egal

<> sau /= Diferit

< Mai mic

<= Mai mic sau egal

> Mai mare

>= Mai mare sau egal

Operatorii de adunare şi scădere (+, -) se pot utiliza pentru adunarea sau scăderea a doi vec-
tori. De asemenea, aceşti operatori permit adunarea unei constante la un vector sau scăderea unei con-
stante dintr-un vector.

Operatorul de specificare a domeniului este reprezentat prin două puncte succesive (..).
Acest operator indică un grup de biţi dintr-un vector. De exemplu, A1..A0 indică biţii 1 şi 0 din vec-
torul A.

Operatorul de concatenare, reprezentat prin caracterul ':', permite gruparea unor variabile de
tip bit sau a unor vectori pentru a forma vectori de dimensiune mai mare. Vectorii obţinuţi pot fi utili-
zaţi pentru compararea lor cu valori constante, ca în exemplul următor:

(D3:D2:D1:D0 > 9) & (D3:D2:D1:D0 < 16)

Operatorul de concatenare poate fi utilizat şi pentru specificarea operaţiilor de deplasare şi de
rotire a registrelor. Exemplul următor indică operaţia de rotire la stânga a unui registru de 8 biţi:

D = D6..D0:D7

Constantele 0 şi 1 pot fi concatenate cu variabile de tip bit sau cu vectori, ca în exemplul ur-
mător:

REZ = 0:0:A1:A0

2.6. Adăugarea şi setarea valorii vectorilor

Vectorii (magistralele) permit gruparea unor variabile de tip bit care vor fi referite prin acelaşi
nume. Astfel, se simplifică setarea valorii unor variabile, compararea a două variabile sau compararea
unei variabile cu o constantă. La adăugarea unor circuite logice cu utilitarul Logic Wizard, vectorii
necesari pentru utilizarea acestor circuite sunt adăugaţi în mod automat. La adăugarea unor circuite
logice prin specificarea ecuaţiei acestora sau la adăugarea unor condiţii pentru tranziţii care utilizează
vectori, proiectantul trebuie să adauge în mod explicit vectorii utilizaţi, specificând dimensiunea
acestora prin domeniul biţilor.

2.6.1. Adăugarea vectorilor

Pentru adăugarea unui vector se procedează astfel:

1. Se selectează butonul Draw Vectors , aflat în partea stângă a ecranului.
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2. Se deplasează cursorul deasupra unei zone libere de pe ecran şi se execută un clic cu butonul
din stânga. Va apare simbolul unui vector cu numele implicit VARn, unde n este un întreg, şi
cu dimensiunea implicită 8 (Figura 9.13). Dimensiunea este indicată prin domeniul biţilor, sub
forma [7:0].

Figura 9.13. Simbolul grafic al unui vector cu numele şi dimensiunea implicită.

3. Pentru modificarea numelui şi dimensiunii vectorului, se execută un clic în interiorul dreptun-
ghiului care încadrează simbolul vectorului care este selectat în mod automat după adăugarea
acestuia, sau se execută un clic dublu deasupra simbolului acestuia. Se va deschide fereastra
de dialog Edit Vector (Figura 9.14).

Figura 9.14. Fereastra de dialog Edit Vector.

4. Se modifică numele vectorului în câmpul Name: şi domeniul biţilor în câmpul Range.

5. Opţional, în câmpul Hi-Z se poate introduce numele unui semnal care, atunci când este activ,
determină trecerea magistralei care reprezintă vectorul în starea de înaltă impedanţă. Nivelul
activ al semnalului poate fi setat la 1 sau la 0 în caseta alăturată.

6. Se selectează butonul OK pentru închiderea ferestrei de dialog.

7. Se selectează butonul Select Objects  pentru terminarea adăugării vectorilor.

În cazul în care opţiunea Show Logic Graphics din meniul View este dezactivată, în locul sim-
bolului grafic al vectorului se afişează un dreptunghi conţinând definiţia vectorului. De exemplu, vec-
torul din Figura 9.13 are definiţia următoare:

VAR0[] = 7:0

Aceasta este definiţia vectorului prin indicarea domeniului biţilor. Bitul cel mai semnificativ
al vectorului este indicat de prima cifră; în exemplul anterior, acesta este bitul 7. Dacă se doreşte ca
bitul cel mai semnificativ să fie bitul 0, domeniul trebuie indicat sub forma 0:7.

Un vector poate fi definit şi prin listarea numelui unor variabile care vor fi grupate în vectorul
respectiv, separate prin spaţii. Lista nu poate conţine variabila de ceas, nume de stări sau alţi vectori. O
variabilă poate apare o singură dată în listă. Exemplele următoare indică definiţiile echivalente ale
unui vector N de 4 biţi:

N[] = 3:0
N[] = N3 N2 N1 N0

2.6.2. Setarea valorii vectorilor

Pentru setarea valorii unui vector se poate utiliza unul din formatele următoare:
vector[constantă]
vector <= ecuaţie
vector = ecuaţie
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unde vector este numele vectorului, constantă este o constantă având o valoare mai mică sau egală
cu valoarea maximă posibilă a vectorului, iar ecuaţie este o ecuaţie logică. Un exemplu utilizând
primul format este următorul:

A[^h5A]

Dacă vectorul A are valoarea 5Ah şi vectorul B are valoarea 3Bh, următoarea expresie este
adevărată:

A[^h5A] & B[^3B]

Al doilea şi al treilea format se poate utiliza pentru asignarea unor ecuaţii la vectorii de ieşire;
aceşti vectori nu pot conţine variabile de stare. Ecuaţia din partea dreaptă a unei asignări trebuie să se
evalueze la un vector cu acelaşi număr de biţi ca şi vectorul din partea stângă a asignării. Ecuaţiile pot
conţine operatori logici, operatori de adunare şi scădere, operatori de comparaţie şi expresii de tip bit
(care sunt expandaţi automat la dimensiunea corectă).

Biţii individuali ai unui vector pot fi setaţi utilizând ecuaţii care conţin măşti corespunzătoare
pentru fiecare bit. De exemplu, pentru a seta bitul 3 al vectorului N la valoarea A#B, bitul 2 la valoarea
C&D, bitul 1 la valoarea !A, iar bitul 0 la valoarea TRUE, se poate scrie ecuaţia următoare:

N = (8 & (A#B)) # (4 & (C&D)) # (2 & !A) # (1)

Atunci când un vector se utilizează ca semnal de ieşire al unei stări sau al unei tranziţii, se pot
asigna biţii individuali ai vectorului, fără a fi necesară scrierea ecuaţiei complete pentru întregul vec-
tor. Ecuaţia din exemplu anterior poate fi scrisă sub forma a patru ecuaţii separate pentru biţii indivi-
duali ai vectorului:

N3 = A#B;
N2 = C&D;
N1 = !A;
N0 = '1';

2.7. Adăugarea variabilelor şi modificarea atributelor acestora

Variabilele se utilizează pentru identificarea semnalelor şi a stărilor. Toate variabilele utilizate
pentru descrierea unui automat de stare trebuie definite. Variabilele pot fi definite (adăugate) fie în
mod automat de către editorul StateCAD, fie în mod explicit de proiectant. Fiecare variabilă are mai
multe atribute. Principalele atribute sunt descrise în continuare.

• Type. Reprezintă tipul variabilei, care indică dacă variabila identifică un semnal de intrare, un
semnal de ieşire, un semnal de ceas sau o stare. Semnalele de intrare se utilizează pentru speci-
ficarea condiţiilor pentru tranziţii şi în ecuaţiile logice. Semnalele de ieşire sunt setate de au-
tomatul de stare ca rezultat al trecerii în anumite stări sau al anumitor tranziţii. Semnalul de
ceas este utilizat de circuitele secvenţiale din cadrul automatului. Acest semnal este adăugat în
mod automat de editorul StateCAD. Variabilele de stare identifică stările automatului. Un set
de variabile de stare va avea o valoare unică pentru fiecare stare. Semnalele de ieşire pot fi
combinaţionale (Combinational) sau secvenţiale (Registered). Semnalele combinaţionale îşi
modifică valoarea imediat ce se modifică semnalele de care depind. Semnalele secvenţiale nu
îşi modifică valoarea imediat, ci numai la apariţia unui front activ al semnalului de ceas.

• Active. Indică nivelul activ al variabilei (0 sau 1). Dacă nivelul activ al unei variabile este 0,
într-o ecuaţie valoarea logică a variabilei este adevărată dacă variabila este 0. În mod implicit,
variabilele adăugate în mod automat vor avea nivelul activ 1. Nivelul activ implicit al variabi-
lelor poate fi setat în fereastra Variables, descrisă mai jos. Variabilele sunt iniţializate implicit
cu nivelele lor inactive.

• Pin/Node. Acest atribut indică dacă semnalul la care se referă variabila este vizibil din exterio-
rul automatului (este un pin de I/E) sau este un semnal intern (nod) care nu este vizibil din ex-
terior.
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• Pin Number. Indică numărul pinului din circuitul programabil asignat semnalului la care se re-
feră variabila. Acest atribut se poate utiliza numai dacă limbajul în care va fi translatată dia-
grama de stare este ABEL.

• Hi-Z. Acest atribut indică dacă semnalul la care se referă variabila poate fi trecut în starea de
înaltă impedanţă prin activarea unui semnal de control. Nivelul activ al semnalului de control
poate fi setat la 1 sau la 0.

Implicit, variabilele sunt adăugate în mod automat de către editorul StateCAD. În acest caz,
atunci când se compilează un automat de stare şi se întâlneşte numele unei noi variabile, aceasta va fi
adăugată în mod automat, tipul variabilei adăugate fiind determinat din contextul în care se întâlneşte
numele variabilei. Adăugarea automată a variabilelor poate fi dezactivată prin deselectarea opţiunii
Add Variables Automatically din secţiunea Options a ferestrei de dialog Configuration (deschisă prin
comanda Options → Configuration). Dacă adăugarea automată a variabilelor este dezactivată, la com-
pilarea automatului şi întâlnirea unei noi variabile se va afişa un mesaj prin care proiectantului i se
solicită să confirme adăugarea variabilei. Astfel, proiectantul poate verifica dacă numele variabilei este
corect şi va cunoaşte tipul care va fi atribuit variabilei (de intrare, de ieşire sau de stare).

Pentru adăugarea unei variabile sau modificarea atributelor unei variabile existente, se proce-
dează astfel:

1. Se selectează comanda Options → Variable, sau se execută un clic cu butonul din dreapta în
orice zonă a ecranului şi se selectează opţiunea Variable. Se va deschide fereastra de dialog
Variables (Figura 9.15). În această fereastră sunt afişate numele variabilelor definite şi atribu-
tele lor.

Figura 9.15. Fereastra de dialog Variables.

2. Se introduce numele variabilei care trebuie adăugată în câmpul Name:, sau se selectează vari-
abila ale cărei atribute trebuie modificate.

3. Se selectează tipul variabilei prin selectarea succesivă a butonului de sub câmpul Type, până
când se afişează tipul dorit. Tipul va fi modificat succesiv în INPUT (intrare), OUT:COM
(ieşire combinaţională), OUT:REG (ieşire secvenţială) sau STATE (stare). Pentru asignarea
unei variabile ca variabilă de stare (atributul STATE), este necesară selectarea asignării manu-
ale a stărilor sau a asignării binare. Metoda de asignare a stărilor poate fi selectată în fereastra
de dialog Configuration, deschisă prin comanda Options → Configuration. În secţiunea State
Assignment a acestei ferestre se selectează opţiunea Manual pentru asignarea manuală a stări-
lor, sau opţiunea Binary Encode pentru asignarea binară. Tipul variabilei de ceas (CLOCK) şi
cel al variabilelor de stare (STATE) sau al vectorilor (VECTOR) nu poate fi modificat.
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4. Dacă este necesar, se modifică nivelul activ al variabilei prin selectarea butonului de sub câm-
pul Active. Nivelul va fi modificat din HIGH (1) în LOW (0) sau invers. Nivelul activ impli-
cit al variabilelor care vor fi adăugate ulterior poate fi modificat prin comutarea butonului din
dreapta câmpului Add new variables as: din partea de jos a ferestrei.

5. Dacă este necesar, se modifică atributul Pin/Node al variabilei prin selectarea butonului de sub
câmpul Pin/Node. Atributul va fi modificat din PIN în NODE sau invers.

6. În mod opţional, se poate introduce în câmpul Hi-Z when numele unui semnal de control care,
atunci când este activ, determină trecerea în starea de înaltă impedanţă a semnalului la care se
referă variabila selectată. Nivelul activ al acestui semnal de control poate fi selectat în caseta
Value.

7. Se selectează butonul OK pentru închiderea ferestrei de dialog.

2.8. Compilarea diagramei de stare

După editarea diagramei de stare, aceasta poate fi compilată pentru generarea unui cod într-un
limbaj de descriere hardware (VHDL, Verilog sau ABEL). Codul obţinut poate fi utilizat apoi pentru
simularea sau sinteza automatului de stare. La compilarea diagramei de stare, aceasta este analizată
pentru a se detecta nu numai erorile sintactice, ci şi un număr mare de erori logice (de proiectare).

Pentru compilarea diagramei de stare, se selectează butonul Generate HDL  sau se exe-
cută comanda Options → Compile. Dacă în timpul compilării se detectează o eroare, compilarea este
oprită, iar în fereastra View Error se afişează problema găsită şi se propune o soluţie pentru rezolvarea
acesteia (Figura 9.16). Se poate selecta butonul Help pentru afişarea unor informaţii suplimentare des-
pre eroarea detectată.

Figura 9.16. Fereastra View Error pentru afişarea unui mesaj de eroare la compilare.

Dacă în timpul compilării se detectează probleme de proiectare, acestea sunt afişate sub forma
unor mesaje de avertisment în fereastra View Warnings. Se explică fiecare problemă detectată şi se
sugerează soluţii pentru rezolvarea acestora.

Dacă opţiunea Optimize Port I/O din fereastra Configuration este validată, la compilare se
testează toate semnalele pentru a determina dacă acestea sunt semnale interne de reacţie din cadrul
automatului de stare. Dacă se detectează un astfel de semnal care este vizibil în afara automatului (este
un pin de I/E), se afişează fereastra de dialog Optimize I/O Port. În această fereastră se selectează
semnalele care vor fi optimizate prin transformarea lor în semnale interne (noduri), după care se se-
lectează butonul Optimize. De asemenea, optimizarea se poate dezactiva prin selectarea opţiunii
Disable Optimize Port I/O sau optimizarea se poate abandona pentru compilarea curentă prin selecta-
rea butonului Cancel.

Dacă nu se detectează erori sau avertismente, StateCAD generează descrierea HDL corespun-
zătoare diagramei de stare şi se afişează fereastra Results cu informaţii despre rezultatele compilării
(Figura 9.17). Se indică numărul liniilor sursă generate, timpul în care s-a executat compilarea, numă-
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rul de stări şi de tranziţii ale diagramei de stare, ca şi operaţiile de analiză care au fost executate de
compilator.

Figura 9.17. Fereastra Results pentru afişarea informaţiilor despre rezultatele compilării.

După închiderea ferestrei Results, StateCAD deschide automat fereastra StateCAD HDL
Browser pentru afişarea codului HDL generat.

2.9. Verificarea funcţionării automatelor cu programul StateBench

2.9.1. Prezentarea programului StateBench

Programul StateBench permite verificarea funcţionării automatelor de stare create cu editorul
StateCAD şi generarea bancurilor de test pentru aceste automate. Acest program realizează simularea
funcţională a automatelor pe baza condiţiilor iniţiale specificate de proiectant şi a rezultatelor care tre-
buie generate. StateBench compară rezultatele specificate ca fiind corecte cu rezultatele obţinute la
simulare şi indică dacă automatul funcţionează conform aşteptărilor. În cazul obţinerii unor rezultate
diferite de cele aşteptate, programul StateBench simplifică identificarea cauzei problemelor apărute.

Pe baza condiţiilor iniţiale specificate, a rezultatelor aşteptate şi, eventual, a unei secvenţe de
stări care trebuie urmărită, programul StateBench generează un banc de test în limbajul VHDL sau
Verilog, care poate fi utilizat pentru simularea funcţionării automatului de stare cu majoritatea simu-
latoarelor, de exemplu, cu simulatorul ModelSim. Prin adăugarea unor constrângeri de timp, bancul de
test generat poate fi utilizat pentru verificarea funcţionării automatului după implementarea acestuia
într-un circuit programabil. Programul StateBench poate genera un banc de test şi în mod automat,
aplicând automatului toate combinaţiile semnalelor de intrare şi încercând parcurgerea tuturor stărilor
şi tranziţiilor din diagrama de stare.

2.9.2. Lansarea programului StateBench

Programul StateBench poate fi lansat în execuţie din fereastra editorului StateCAD, prin exe-

cuţia comenzii Options → StateBench sau selectarea butonului StateBench . La lansarea pro-
gramului StateBench, editorul StateCAD compilează diagrama de stare şi verifică eventualele erori. În
scopul generării unui banc de test funcţional şi valid, se testează dacă în cadrul editorului StateCAD
este validată verificarea principalelor erori, cum sunt tranziţii nedeterminate sau semnale de ieşire
forţate la valori constante. Aceste verificări sunt validate în mod implicit şi setările corespunzătoare



Arhitectura calculatoarelor - Lucrarea de laborator Nr. 920

sunt afişate în secţiunea Check For a ferestrei de dialog Configuration. Dacă se detectează invalidarea
verificării acestor erori, se afişează o fereastră de dialog pentru confirmarea validării acestor verificări.

Dacă sunt detectate erori la compilarea diagramei, se afişează fereastra View Error şi compila-
rea este oprită. Dacă nu sunt detectate erori, se deschide fereastra programului StateBench (Figura
9.18). Această fereastră se afişează în jumătatea de jos a ecranului, diagrama de stare fiind afişată în
jumătatea de sus a ecranului. În fereastra programului StateBench sunt afişate toate semnalele utilizate
în cadrul automatului de stare, iniţializate în mod implicit cu valoarea 0. Semnalele de intrare sunt afi-
şate cu culoarea albastră, iar cele de ieşire sunt afişate cu culoarea maro. Culorile cu care se afişează
semnalele şi ordinea de afişare a acestora pot fi modificate prin comanda Options → Signal Editor.

Figura 9.18. Fereastra programului StateBench.

2.9.3. Verificarea funcţionării cu comanda Verify Behavior

Metoda cea mai simplă de verificare a funcţionării automatului de stare constă în utilizarea
comenzii Verify Behavior. Această comandă permite setarea condiţiilor iniţiale pentru automatul de
stare, alegerea stării până la care să se execute simularea şi setarea valorilor aşteptate ale semnalelor în
această stare. Programul StateBench va executa apoi simularea funcţionării automatului, urmărind
tranziţiile între stări pe baza condiţiilor iniţiale, şi va afişa diagrama de timp (forma de undă) a sem-
nalelor. Dacă se ajunge în starea selectată, se poate selecta o altă stare sau se poate opri simularea.
Este posibil ca programul StateBench să nu poată dirija funcţionarea automatului până în starea selec-
tată, caz în care simularea poate fi continuată prin alte comenzi.

Pentru verificarea funcţionării automatului de stare utilizând comanda Verify Behavior, se
procedează astfel:

1. Se selectează comanda Options → Verify Behavior sau butonul Verify Behavior . Se va
deschide fereastra de dialog Verify Behavior (Figura 9.19).

2. În secţiunea Set initial conditions se setează valorile iniţiale ale semnalelor. Pentru aceasta, se
execută un clic dublu pe numele unui semnal care trebuie iniţializat. Dacă semnalul este de tip
bit, valoarea acestuia va fi modificată (din 0 în 1 sau invers). Dacă semnalul este un vector, se
va afişa fereastra Assign Value, care permite introducerea valorii vectorului în câmpul Value.
Valoarea poate fi introdusă în zecimal sau hexazecimal. Se selectează butonul OK, după care
se iniţializează în mod similar celelalte semnale de intrare ale automatului.

3. În secţiunea Choose the target state se selectează starea până la care să se execute simularea
(starea destinaţie).
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Figura 9.19. Fereastra de dialog Verify Behavior.

4. În mod opţional, se setează valorile aşteptate ale semnalelor de ieşire în starea destinaţie. Pen-
tru aceasta, în secţiunea Select the signals ... se execută un clic dublu pe numele semnalului
care trebuie verificat dacă se ajunge în starea destinaţie. Se va afişa fereastra Check Value, ca-
re permite introducerea valorii semnalului în câmpul Value. Pentru a indica starea de înaltă
impedanţă a unui semnal, în câmpul Value se introduce caracterul Z. Se selectează butonul
OK, după care se setează în mod similar valorile celorlalte semnale de ieşire ale automatului.
Valorile aşteptate ale semnalelor de ieşire vor fi salvate în bancul de test generat şi vor fi indi-
cate pe forma de undă a semnalelor. Dacă valoarea unui semnal obţinută la simulare este ace-
eaşi cu valoarea aşteptată, aceasta din urmă este indicată prin culoarea verde, iar dacă există
diferenţe valoarea aşteptată este indicată prin culoarea roşie. De asemenea, dacă există dife-
renţe între valorile semnalelor, se afişează un mesaj şi zona corespunzătoare de pe diagrama
de timp a semnalelor va fi marcată prin culoarea neagră.

5. Se selectează butonul Go. Programul StateBench va executa simularea cu valorile iniţiale spe-
cificate ale semnalelor şi va încerca dirijarea automatului în starea destinaţie indicată. Dacă se
ajunge în această stare, programul va indica eventualele diferenţe între valorile aşteptate ale
semnalelor şi cele obţinute la simulare. Stările care au fost parcurse vor fi indicate pe diagrama
de stare prin culoarea verde, iar starea în care s-a ajuns va fi indicată prin culoarea galbenă. Se
va afişa fereastra de dialog Reached Target State, care permite selectarea unei alte stări desti-
naţie sau oprirea simulării. Dacă nu a fost posibilă dirijarea automatului în starea destinaţie, se
va afişa un mesaj pe ecran şi simularea va fi oprită.

2.9.4. Alte comenzi pentru verificarea funcţionării

Pe lângă comanda Verify Behavior, există mai multe comenzi utile care pot fi utilizate pentru
verificarea funcţionării automatului de stare. Principalele comenzi sunt descrise în continuare.

Comanda Reset, activată prin selectarea butonului Reset , execută un ciclu pentru
resetarea automatului de stare. Dacă există un semnal de resetare sincronă sau asincronă, comanda ac-
tivează acest semnal pe durata unei perioade de ceas, după care dezactivează semnalul de resetare. Da-
că există o condiţie mai complexă de resetare, comanda activează în mod automat semnalele necesare
pentru resetarea automatului de stare. Programul StateBench trasează în mod automat diagrama de
timp a semnalelor în ciclul de resetare al automatului şi pune în evidenţă prin culoarea galbenă starea
în care se realizează tranziţia la resetarea automatului.
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Comanda Cycle, activată prin selectarea butonului Cycle , simulează funcţionarea auto-
matului pe durata unei perioade de ceas şi trasează diagrama de timp a semnalelor. Această comandă
poate fi utilizată, de exemplu, pentru continuarea simulării după execuţia comenzii Verify Behavior.
Diagrama de timp a semnalelor este trasată pe măsura execuţiei simulării, iar starea curentă este indi-
cată prin culoarea galbenă pe diagrama de stare. Pentru execuţia simulării pe durata mai multor pe-
rioade de ceas, se poate introduce comanda cycle n în linia de comandă, unde n este numărul perioa-
delor de ceas. Comanda se introduce în caseta din dreapta butonului Execute, după care se apasă tasta
Enter sau se execută un clic pe butonul Execute.

Execuţia poate fi simulată pentru un timp specificat prin utilizarea comenzii sim n, unde n
este numărul unităţilor de timp (implicit, în ns). Comanda este disponibilă numai din linia de comandă.
Dacă timpul specificat este mai mic decât o perioadă de ceas, simularea se execută pe durata unei pe-
rioade de ceas. Unitatea de timp, durata perioadei de ceas şi constrângerile de timp pot fi setate prin
comanda Options → Timing Constraints.

Comanda Restart, activată prin selectarea butonului Restart , iniţializează simularea au-
tomatului de stare. Această comandă este executată automat la lansarea programului StateBench. Co-
manda iniţializează toate semnalele (implicit, cu valoarea 0), setează timpul de simulare la 0 şi aduce
automatul într-o stare necunoscută (registrul de stare nu este iniţializat). După execuţia acestei co-
menzi, trebuie executată comanda Restart dacă simularea va fi executată cu comanda Cycle sau co-
manda sim.

2.9.5. Salvarea bancului de test

În urma simulării funcţionale a automatului de stare, programul StateBench creează un banc
de test în limbajul VHDL sau Verilog. Acest banc de test generează semnalul de ceas pentru automatul
de stare, iniţializează semnalele de intrare cu valorile specificate şi compară valorile semnalelor de
ieşire obţinute la simulare cu cele aşteptate (dacă acestea au fost specificate de proiectant). Bancul de
test creat poate fi utilizat împreună cu descrierea automatului de stare creată de programul StateCAD
pentru simularea funcţională a automatului cu un alt simulator sau pentru simularea cu constrângeri de
timp după implementare.

La salvarea unui banc de test, se poate salva şi un fişier (“regression file”) conţinând valorile
semnalelor de intrare şi de ieşire obţinute la simularea curentă. Acest fişier poate fi utilizat ulterior cu
programul StateBench pentru execuţia simulării în aceleaşi condiţii, fără a fi necesară specificarea din
nou a condiţiilor iniţiale şi a stărilor care trebuie parcurse.

Pentru salvarea bancului de test conţinând rezultatele simulării curente, se execută comanda

File → Save Test Bench sau se selectează butonul Save Test Bench . Se va deschide fereastra de
dialog Save Test Bench/Regression (Figura 9.20). În această fereastră se pot modifica numele implicite
ale celor două fişiere care vor fi salvate şi se pot selecta unele opţiuni.

Figura 9.20. Fereastra de dialog Save Test Bench/Regression.

Dacă opţiunea Log results este validată, la simularea automatului cu un alt simulator mesajele
vor fi scrise într-un fişier care poate fi vizualizat cu un editor de texte. Dacă opţiunea Auto verify
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outputs este validată, în bancul de test generat vor fi inserate comenzi de verificare pentru toate sem-
nalele de ieşire în fiecare ciclu de ceas, pe baza valorilor care au fost obţinute la simularea curentă.
Această opţiune este utilă dacă bancul de test va fi utilizat pentru verificarea funcţionării după sinteza
automatului. Pentru salvarea fişierelor se selectează butonul Save. Dacă opţiunea Open automatically
este validată, bancul de test va fi vizualizat automat cu editorul HDL al programului StateCAD sau cu
un alt editor selectat în fereastra Save Test Bench/Regression.

2.9.6. Modificarea valorii semnalelor şi reexecutarea simulării

După execuţia simulării cu anumite condiţii iniţiale şi parcurgerea unei anumite succesiuni a
stărilor, se pot modifica valorile unor semnale pentru a se verifica funcţionarea cu alte condiţii iniţiale
sau pentru alte valori ale semnalelor de intrare.

Metoda cea mai simplă pentru modificarea valorii unui semnal este prin executarea unui clic
dublu pe forma de undă a semnalului, în ciclul de ceas de la care se doreşte modificarea valorii sem-
nalului. Dacă semnalul este de tip bit, valoarea acestuia va fi modificată din 0 în 1 sau invers. Dacă
semnalul este un vector, se va deschide fereastra de dialog Assign Value. Se introduce valoarea vecto-
rului în câmpul Value, după care se selectează butonul OK. În ambele cazuri (semnal de tip bit sau
vector), înainte de modificarea valorii semnalului se afişează o fereastră de dialog. În această fereastră,
se selectează butonul Yes dacă se doreşte modificarea valorii semnalului numai în ciclul de ceas cu-
rent, sau butonul No dacă se doreşte modificarea valorii în toate ciclurile de ceas începând cu ciclul
curent. Valorile semnalelor de intrare vor fi modificate pe diagrama de timp, dar semnalele de ieşire
nu vor fi actualizare decât după executarea din nou a simulării.

Pe lângă modificarea valorii unor semnale de intrare, poate fi necesară şi modificarea valorii
aşteptate a semnalelor de ieşire. Pentru a introduce valoarea aşteptată a unui semnal de ieşire în scopul
comparării acestei valori cu valoarea obţinută la simulare, se execută un clic dublu pe forma de undă a
semnalului în starea în care trebuie verificată valoarea semnalului. Se va deschide fereastra de dialog
Assertions, în care se selectează opţiunea Add pentru adăugarea valorii pe diagramă şi se selectează
butonul OK. Se va deschide fereastra de dialog Assign Value, în care se poate introduce valoarea dori-
tă. Dacă în ciclul de ceas respectiv a fost setată anterior o valoare, aceasta poate fi modificată în fe-
reastra de dialog Assertions prin selectarea opţiunii Modify the expected value, sau poate fi ştearsă prin
selectarea opţiunii Delete. Pentru ştergerea valorilor aşteptate ale tuturor semnalelor, se poate executa
comanda Options → Clear Assertions.

După modificarea valorii semnalelor, se poate reexecuta simularea. Pentru aceasta, se execută

comanda File → Run Test Bench sau se selectează butonul Run Test Bench . Se va afişa o fe-
reastră de dialog, în care se selectează butonul Yes pentru reexecutarea simulării curente cu valorile
modificate ale semnalelor. Dacă se selectează butonul No, se poate executa o simulare salvată anterior
într-un fişier.

2.10. Exemplu de proiectare

În continuare se descriu etapele care trebuie parcurse pentru proiectarea unui circuit pentru
înmulţirea a două numere fără semn de câte 4 biţi prin metoda directă. Atât unitatea de comandă a cir-
cuitului de înmulţire, cât şi partea de prelucrare vor fi proiectate cu ajutorul editorului pentru diagrame
de stare StateCAD.

2.10.1. Descrierea circuitului proiectat

Schema bloc a circuitului de înmulţire este prezentată în Figura 9.21. Registrele RX şi RY se
utilizează pentru comunicaţia cu circuitul de înmulţire. În aceste registre se încarcă deînmulţitul X,
respectiv înmulţitorul Y înaintea începerii operaţiei de înmulţire. Registrul B păstrează deînmulţitul în
timpul operaţiei de înmulţire. În registrul Q se încarcă înmulţitorul la începutul operaţiei, iar acest re-
gistru va conţine biţii cei mai puţin semnificativi ai produsului la sfârşitul operaţiei. Registrul A este
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un registru acumulator, care este iniţializat cu 0 la începutul operaţiei. Acest registru păstrează produ-
sul parţial în timpul operaţiei şi va conţine biţii cei mai semnificativi ai produsului la sfârşitul operaţi-
ei. Sumatorul de 4 biţi se utilizează pentru adunarea repetată a deînmulţitului din registrul B la produ-
sul parţial din registrul A. Unitatea de comandă conţine un numărător N, care este iniţializat cu 4 la
începutul operaţiei şi este decrementat cu 1 în fiecare pas al operaţiei. Atunci când numărătorul N
ajunge la valoarea 0, operaţia de înmulţire este terminată. Semnalul START trebuie activat pentru a
iniţia operaţia de înmulţire. Semnalul TERM este activat de circuitul de înmulţire pentru a indica ter-
minarea operaţiei.

Figura 9.21. Schema bloc a circuitului de înmulţire prin metoda directă.

Înaintea începerii operaţiei de înmulţire, se încarcă deînmulţitul X în registrul RX şi înmulţito-
rul Y în registrul RY. Pentru începerea operaţiei, se activează semnalul START. Ca urmare, circuitul de
înmulţire efectuează următoarele operaţii de iniţializare: transferă conţinutul registrului RX în registrul
B, transferă conţinutul registrului RY în registrul Q, iniţializează registrul A cu 0 şi iniţializează numă-
rătorul N cu 4. În fiecare pas al operaţiei, se testează bitul c.m.p.s. al înmulţitorului (Q0), iar dacă acest
bit este 1, se adună deînmulţitul (aflat în registrul B) la produsul parţial (păstrat în registrul A). În con-
tinuare, se deplasează registrele A şi Q la dreapta cu o poziţie, iar bitul c.m.p.s. al registrului A se
transferă în poziţia c.m.s. a registrului Q. Se decrementează numărătorul N, iar dacă acesta nu este 0,
se continuă operaţia cu testarea bitului c.m.p.s. al înmulţitorului. La sfârşitul operaţiei, se activează
semnalul TERM, care indică faptul că registrele A şi Q conţin rezultatul înmulţirii.

Figura 9.22. Diagrama de stare a circuitului de înmulţire prin metoda directă.

Circuitul de înmulţire poate fi considerat un automat de stare, astfel încât funcţionarea acestuia
poate fi descrisă printr-o diagramă de stare. Diagrama de stare a circuitului este ilustrată în Figura
9.22. Această diagramă conţine 6 stări distincte. Starea S0 este o stare de repaus, în care circuitul aş-
teaptă activarea semnalului START pentru începerea operaţiei de înmulţire. Dacă semnalul START de-
vine 1, se trece în starea S1, în care se efectuează operaţiile de iniţializare, care pot fi descrise în mod
simbolic astfel:

B ← RX; Q ← RY; A ← 0; N ← 4;
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În starea S2 se decrementează numărătorul N. Decrementarea se efectuează înaintea fiecărui
pas al operaţiei de înmulţire şi nu după fiecare pas, aşa cum s-a descris mai sus, pentru simplificarea
diagramei de stare. Dacă bitul Q0 este 1, se trece în starea S3, în care se adună deînmulţitul la produsul
parţial:

A ← A + B;

Din starea S3 se trece necondiţionat în starea S4, în care se deplasează la dreapta registrele A
şi Q cu o poziţie. În starea S4 se trece şi din starea S2, dacă bitul Q0 este 0. Din starea S4 se trece în
starea S2 dacă numărătorul N nu este 0, sau în starea S5 dacă numărătorul N este 0. În starea S5 se ac-
tivează semnalul TERM care indică terminarea operaţiei, după care se trece în starea de repaus S0.

2.10.2. Crearea proiectului

Pentru crearea unui nou proiect, se lansează în execuţie programul Xilinx WebPACK, după
care se execută următoarele etape:

1. În ecranul Project Navigator se selectează File → New Project. Se va deschide fereastra de
dialog New Project.

2. În câmpul Project Location se selectează subdirectorul în care se va crea proiectul (un subdi-
rector din directorul C:\Student\).

3. În câmpul Project Name se introduce numele proiectului, de exemplu, lab9_1.

4. Se verifică setările corecte în câmpurile Device Family şi Device (Spartan2, respectiv
xc2s50-5tq144).

5. În câmpul Design Flow se selectează fluxul de proiectare: XST VHDL.

6. Se selectează butonul OK pentru a crea proiectul.

2.10.3. Lansarea în execuţie a programului StateCAD

Pentru lansarea în execuţie a programului StateCAD şi crearea unui fişier pentru diagrama de
stare, se procedează astfel:

1. Se selectează comanda Project → New Source.

2. În fereastra de dialog New, se selectează opţiunea State Diagram.

3. În câmpul File Name se introduce numele fişierului în care se va păstra diagrama de stare, de
exemplu, inm_dir.

4. Se selectează butonul Next.

5. În fereastra de dialog New Source Information, se selectează butonul Finish.

Se va lansa în execuţie programul StateCAD într-o nouă fereastră.

2.10.4. Crearea automatului de stare

Pentru crearea automatului de stare se va folosi utilitarul State Machine Wizard.

1. Se selectează butonul Draw State Machines . Se va deschide fereastra State Machine
Wizard.

2. În câmpul Shape of state machine se selectează opţiunea Row pentru plasarea stărilor auto-
matului pe linie.
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3. În câmpul Number of States se selectează 5 ca număr de stări ale automatului. Ulterior, se va
introduce o stare suplimentară.

4. Se selectează butonul Next. Se va deschide fereastra de dialog Reset The State Machine.

5. În câmpul Reset Mode se selectează opţiunea Asynchronous pentru a se genera o logică asin-
cronă de resetare a automatului de stare.

6. Se selectează butonul Next. Se va deschide fereastra de dialog Setup Transitions.

7. În câmpul Add Transitions se selectează tipul tranziţiilor care vor fi prezente în diagrama de
stare. În mod implicit, va fi selectată doar opţiunea Next, opţiunile Loop back şi Previous fiind
neselectate. Astfel, diagrama va conţine doar tranziţii de la fiecare stare la starea următoare a
acesteia. Se păstrează aceste setări.

8. Se selectează butonul Finish. În fereastra editorului StateCAD se va afişa un dreptunghi cu
conturul de culoare verde, care indică marginile diagramei.

9. Se deplasează dreptunghiul în zona centrală a ferestrei şi se execută un clic cu butonul din
stânga. Se va afişa diagrama de stare cu forma ilustrată în Figura 9.23.

Figura 9.23. Forma iniţială a diagramei de stare creată cu utilitarul State Machine Wizard.

2.10.5. Adăugarea unei stări suplimentare

Pentru adăugarea unei stări suplimentare la diagrama creată anterior, se procedează astfel:

1. Se selectează butonul Draw States , aflat în partea stângă a ecranului.

2. Se deplasează cursorul deasupra stării STATE2, după care se execută un clic cu butonul din
stânga. Simbolul stării va fi plasat pe diagramă. StateCAD va atribui numele STATE5 noii
stări.

3. Se selectează butonul Select Objects .

2.10.6. Editarea stărilor

În continuare se modifică numele stărilor astfel încât acestea să reflecte funcţia lor şi se speci-
fică semnalele de ieşire care trebuie activate în stările respective. Pentru aceasta se execută următoa-
rele operaţii:

1. Se execută un clic dublu pe simbolul stării STATE0. Se va afişa fereastra de dialog Edit State.

2. În câmpul State Name, se introduce noul nume al stării, repaus, după care se selectează buto-
nul OK.

3. Se execută un clic dublu pe simbolul stării STATE1. În câmpul State Name se introduce nu-
mele init. În câmpul Outputs se introduc următoarele ecuaţii indicând valorile cu care se iniţi-
alizează registrele şi semnalul TERM:

B=RX;Q=RY;<Enter>
A=0;N=4;<Enter>
TERM='0';
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Se selectează apoi butonul OK.

4. Se execută un clic dublu pe simbolul stării STATE2. În câmpul State Name se introduce nu-
mele decrem_N şi se selectează butonul OK.

5. Se execută un clic dublu pe simbolul stării STATE3. În câmpul State Name se introduce nu-
mele deplas_AQ şi se selectează butonul OK.

6. Se execută un clic dublu pe simbolul stării STATE4. În câmpul State Name se introduce nu-
mele termin. În câmpul Outputs se introduce valoarea semnalului TERM:

TERM='1';

Se selectează apoi butonul OK.

7. Se execută un clic dublu pe simbolul stării STATE5 (starea care a fost adăugată separat). În
câmpul State Name se introduce numele adun_B şi se selectează butonul OK.

2.10.7. Adăugarea unor tranziţii suplimentare

Pentru completarea diagramei de stare cu tranziţiile care nu au fost generate în mod automat,
se procedează astfel:

1. Se selectează butonul Draw Transitions , aflat în partea stângă a ecranului.

2. Se selectează starea decrem_N prin execuţia unui clic în interiorul stării, iar apoi se execută
un nou clic în interiorul stării, în apropierea marginii de sus. Va apare un pătrat de culoare ro-
şie pe marginea simbolului stării, iar un alt pătrat va urmări deplasarea cursorului.

3. Se deplasează cursorul deasupra stării adun_B. Va apare un pătrat de culoare roşie pe margi-
nea simbolului stării şi o linie între stările decrem_N şi adun_B. Se fixează poziţia punctului
de capăt al liniei şi se execută un clic în poziţia respectivă. Dacă o linie de tranziţie nu a fost
adăugată în mod corespunzător, aceasta va fi ştearsă prin apăsarea tastei Delete, iar apoi va fi
adăugată din nou.

4. În acelaşi mod se adaugă o tranziţie de la starea adun_B la starea deplas_AQ.

5. Se procedează similar pentru adăugarea unei tranziţii de la starea deplas_AQ la starea
decrem_N. Pentru transformarea liniei de tranziţie într-o linie curbă, se execută un clic pe
unul din cele două puncte de control din interiorul liniei (puncte indicate prin pătrate cu contu-
ruri de culoare roşie), iar apoi se repoziţionează punctul prin deplasarea cursorului în jos,
menţinând butonul apăsat. Se procedează similar cu al doilea punct de control.

6. Se adaugă o tranziţie de buclare pentru starea repaus. Pentru aceasta, se execută un clic dublu
în interiorul simbolului acestei stări, în apropierea marginii de sus. Editorul va adăuga linia
pentru tranziţia de buclare (care începe şi se termină în starea repaus) şi va adăuga condiţia
@ELSE pentru această tranziţie.

7. Se selectează butonul Select Objects  pentru a termina adăugarea tranziţiilor.

2.10.8. Adăugarea condiţiilor pentru tranziţii

Pentru adăugarea condiţiilor care determină execuţia tranziţiilor, se execută următoarele ope-
raţii:

1. Se execută un clic dublu pe linia tranziţiei de la starea repaus la starea init. Se va deschide fe-
reastra de dialog Edit Condition. În câmpul Condition se introduce condiţia START (sau
START='1'), iar apoi se selectează butonul OK. Se deplasează dreptunghiul de culoare roşie
deasupra liniei de tranziţie.
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2. Se execută un clic dublu pe linia tranziţiei de la starea decrem_N la starea adun_B. În câmpul
Condition se introduce condiţia Q0=1 (sau Q0) şi se selectează butonul OK. Se deplasează
dreptunghiul de culoare roşie în stânga liniei de tranziţie.

3. Se execută un clic dublu pe linia tranziţiei de la starea decrem_N la starea deplas_AQ. În
câmpul Condition se introduce condiţia Q0=0 (sau !Q0) şi se selectează butonul OK. Se de-
plasează dreptunghiul de culoare roşie deasupra liniei de tranziţie.

4. Se execută un clic dublu pe linia tranziţiei de la starea deplas_AQ la starea decrem_N. În
câmpul Condition se introduce condiţia N/=0 şi se selectează butonul OK. Se deplasează
dreptunghiul de culoare roşie sub linia de tranziţie.

5. Se execută un clic dublu pe linia tranziţiei de la starea deplas_AQ la starea termin. În câmpul
Condition se introduce condiţia N=0 şi se selectează butonul OK. Se deplasează dreptunghiul
de culoare roşie deasupra liniei de tranziţie.

După execuţia acestor operaţii, diagrama de stare va arăta ca în Figura 9.24. Se salvează fişie-
rul cu diagrama de stare prin selecţia butonului Save File.

Figura 9.24. Forma diagramei de stare după editarea acesteia.

2.10.9. Adăugarea circuitelor logice

Pentru executarea operaţiilor elementare din care se compune operaţia de înmulţire trebuie
adăugate circuitele logice corespunzătoare. Aceste circuite vor fi adăugate în mod automat de editorul
StateCAD dacă se specifică ecuaţiile ieşirilor care trebuie generate în stările respective. Se vor adăuga
următoarele circuite: numărătorul N, care se decrementează în fiecare pas al operaţiei; sumatorul de 4
biţi, utilizat pentru adunarea deînmulţitului din registrul B la produsul parţial din registrul A; registrele
A şi Q, care se deplasează la dreapta cu o poziţie în fiecare pas al operaţiei.

Pentru adăugarea numărătorului N, se execută următoarele operaţii:

1. Se execută un clic dublu pe simbolul stării decrem_N. Se va deschide fereastra de dialog Edit
State.

2. Se selectează butonul Output Wizard, prin care se va deschide fereastra de dialog Logic
Wizard.

3. În lista afişată în partea din stânga sus a ferestrei se selectează circuitul Count Down.

4. În câmpul COUNT se introduce N ca nume al semnalului de ieşire al numărătorului.

5. În câmpul Data path width se selectează 2 ca dimensiune a vectorului reprezentând semnalul
de ieşire al numărătorului.

6. Se verifică selectarea opţiunii Registered, prin care semnalul de ieşire va fi secvenţial.

7. Se selectează butonul OK. Utilitarul Logic Wizard generează ecuaţia logică a numărătorului,
defineşte vectorul care reprezentă semnalul de ieşire al acestuia şi va deschide apoi fereastra
de dialog Edit Equation. În câmpul Outputs al acestei ferestre va apare ecuaţia numărătorului:
N = N-1.
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8. Se selectează butonul OK. Ecuaţia numărătorului va apare sub numele stării decrem_N. Sub
diagrama de stare va apare simbolul vectorului N[1:0], indicând definirea acestui vector.

Pentru adăugarea sumatorului, se procedează astfel:

1. Se execută un clic dublu pe simbolul stării adun_B. Se va deschide fereastra de dialog Edit
State.

2. Se selectează butonul Output Wizard, prin care se va deschide fereastra de dialog Logic
Wizard.

3. În lista afişată se selectează circuitul Adder.

4. În câmpul A se introduce A, iar în câmpul B se introduce B. Aceştia sunt cei doi operanzi care
vor fi adunaţi.

5. În câmpul DEST se introduce A ca destinaţie a operaţiei de adunare.

6. În câmpul Data path width se selectează valoarea 4 ca dimensiune a vectorilor care vor fi adu-
naţi.

7. Se selectează butonul OK. Utilitarul Logic Wizard generează ecuaţia logică a sumatorului, de-
fineşte vectorii care vor fi adunaţi şi va deschide fereastra de dialog Edit Equation. În câmpul
Outputs al acestei ferestre va apare ecuaţia sumatorului: A = (A+B).

8. Se selectează butonul OK. Ecuaţia sumatorului va apare sub numele stării adun_B. În fereas-
tra diagramei de stare vor apare simbolurile vectorilor A[3:0] şi B[3:0], indicând definirea
acestor vectori.

Pentru adăugarea registrelor de deplasare A şi Q, se procedează astfel:

1. Se execută un clic dublu pe simbolul stării deplas_AQ. Se va deschide fereastra de dialog Edit
State.

2. Se selectează butonul Output Wizard, prin care se va deschide fereastra de dialog Logic
Wizard.

3. În lista afişată se selectează circuitul Shift Right.

4. În câmpul DIN se introduce A3, iar în câmpul DOUT se introduce A.

5. În câmpul Data path width se setează valoarea 4 ca dimensiune a registrului de deplasare.

6. Se selectează butonul OK. Se va deschide fereastra de dialog Edit Equation. În câmpul
Outputs al acestei ferestre va apare ecuaţia registrului de deplasare: A = A3:A3..A1.

7. Se selectează butonul Output Wizard, prin care se va deschide din nou fereastra de dialog Lo-
gic Wizard.

8. Se selectează circuitul Shift Right.

9. În câmpul DIN se introduce A0, iar în câmpul DOUT se introduce Q.

10. În câmpul Data path width se setează valoarea 4 ca dimensiune a registrului de deplasare.

11. Se selectează butonul OK. Se va deschide fereastra de dialog Edit Equation. În câmpul
Outputs al acestei ferestre, sub ecuaţia registrului de deplasare A, va apare ecuaţia registrului
de deplasare Q: Q = A0:Q3..Q1.

12. Se selectează butonul OK. Ecuaţiile registrelor de deplasare vor apare sub numele stării
deplas_AQ. În fereastra diagramei de stare va apare simbolul vectorului Q[3:0], indicând de-
finirea acestui vector.

Se salvează fişierul cu diagrama de stare prin selectarea butonului Save File.
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2.10.10. Adăugarea unor noi vectori

Programul StateCAD defineşte în mod automat vectorii care au fost utilizaţi în ecuaţiile circu-
itelor logice adăugate pentru generarea semnalelor de ieşire. Dimensiunea acestor vectori este cunos-
cută prin selectarea valorii câmpului Data path width al ferestrei de dialog Logic Wizard. Variabilele
de tip vector care nu apar în ecuaţiile circuitelor logice adăugate trebuie definite în mod explicit de
proiectant, specificând dimensiunea acestora. În caz contrar, aceste variabile vor fi considerate de tip
bit.

În cazul circuitului de înmulţire, variabilele de tip vector a căror dimensiune nu a fost specifi-
cată sunt RX şi RY. Pentru definirea acestor variabile ca vectori, se procedează astfel:

1. Se selectează butonul Draw Vectors , aflat în partea stângă a ecranului.

2. Se deplasează cursorul într-o zonă liberă de sub diagrama de stare şi se execută un clic cu bu-
tonul din stânga. Va apare simbolul unui vector VAR0[7:0], cu dimensiunea 8.

3. Se plasează un al doilea vector în dreapta primului. Va apare simbolul vectorului VAR1[7:0].
4. Se selectează butonul Select Objects  pentru terminarea adăugării vectorilor.

5. Pentru modificarea numelui şi dimensiunii vectorului VAR0, se execută un clic dublu deasu-
pra simbolului acestuia. Se va deschide fereastra de dialog Edit Vector.

6. În câmpul Name se modifică numele vectorului în RX, iar în câmpul Range se modifică do-
meniul biţilor în 3:0. Se selectează apoi butonul OK. Se poate afişa o fereastră indicând faptul
că variabila RX este utilizată. În acest caz, se selectează butonul Yes pentru ştergerea variabilei
existente RX şi redenumirea vectorului în RX.

7. Se procedează similar pentru modificarea numelui vectorului VAR1 în RY şi a domeniului
biţilor în 3:0.

2.10.11. Vizualizarea opţiunilor de configuraţie

În continuare se vizualizează opţiunile implicite care vor fi utilizate la compilarea automatului
de stare şi se modifică una din opţiuni.

1. Se selectează comanda Options → Configuration, prin care se va deschide fereastra de dialog
Configuration.

2. În secţiunea Options a acestei ferestre se validează opţiunea Retain Output Values, prin care
semnalele de ieşire care nu sunt specificate în mod explicit într-o stare îşi vor păstra valorile
de la ultima asignare.

3. În secţiunea State Assignment se indică modul în care se va realiza asignarea stărilor. Opţiunea
selectată în mod implicit este One Hot, care indică metoda de asignare cu un bistabil pe stare.
Se poate păstra această opţiune, sau se poate selecta opţiunea Enumerated.

4. Se închide fereastra prin selectarea butonului OK.

2.10.12. Compilarea diagramei de stare şi corectarea erorilor

Pentru compilarea diagramei de stare, se selectează butonul Generate HDL . Se va des-
chide fereastra View Error în care se afişează un mesaj de eroare. Mesajul afişat indică faptul că valoa-
rea 4 asignată vectorului N este mai mare decât domeniul posibil al valorilor vectorului, care este de 2
biţi. Pe diagrama de stare, este pusă în evidenţă starea în care s-a efectuat asignarea; aceasta este starea
init. Se închide fereastra View Error prin selectarea butonului Close.

Pentru corectarea acestei erori şi recompilarea diagramei de stare, se procedează astfel:

1. Se execută un clic dublu pe simbolul vectorului N. Se va deschide fereastra de dialog Edit
Vector.
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2. În câmpul Range se modifică domeniul vectorului din 1:0 în 2:0. Astfel, numărătorul N va fi
de 3 biţi.

3. Se selectează butonul OK. Simbolul vectorului N va conţine noul domeniu

4. Se compilează diagrama de stare prin selectarea butonului Generate HDL. Se va afişa o nouă
eroare în fereastra View Error, indicând o comparaţie ilegală Q0 = 1 sau Q0 = 0. Valoarea cu
care se efectuează comparaţia trebuie să fie o constantă sau o variabilă booleană. Condiţia în
care apare comparaţia ilegală şi tranziţia corespunzătoare sunt puse în evidenţă prin culoarea
roşie pe diagramă. Se închide fereastra View Error.

5. Se execută un clic dublu pe condiţia Q0 = 1. Se va deschide fereastra de dialog Edit
Condition.

6. În câmpul Condition se corectează condiţia existentă Q0 = 1 în Q0 = '1', după care se selec-
tează butonul OK.

7. Se procedează similar pentru modificarea condiţiei Q0 = 0 în Q0 = '0'.

8. Se salvează diagrama de stare prin selectarea butonului Save File.

9. Se compilează din nou diagrama de stare prin selectarea butonului Generate HDL.

10. Dacă se afişează fereastra de dialog Delete Unused Variables, se selectează butonul Delete
pentru ştergerea variabilelor neutilizate.

Figura 9.25. Fereastra de dialog Optimize Port I/O pentru selectarea semnalelor care vor deveni noduri.

11. Se va deschide fereastra de dialog Optimize Port I/O. În această fereastră se pot selecta sem-
nalele care vor deveni noduri (semnale interne) şi cele care vor deveni porturi de I/E. Semna-
lele interne permit efectuarea unor optimizări. Se execută un clic pe numele semnalelor A, Q şi
TERM pentru a elimina marcajul X din faţa numelui acestora (Figura 9.25). Astfel, semnalele
A, Q şi TERM vor deveni porturi de I/E, iar B şi N vor deveni noduri.

12. Se selectează butonul Optimize. Se va afişa fereastra Results indicând compilarea fără erori.
Sunt afişate de asemenea diferite statistici despre automatul de stare generat şi operaţiile
efectuate la compilare.

13. Se închide fereastra Results. Se va deschide fereastra StateCAD HDL Browser în care se afi-
şează fişierul VHDL generat prin compilarea diagramei de stare. Se vizualizează codul gene-
rat, după care se închide această fereastră.
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2.10.13. Verificarea funcţionării cu programul StateBench

Pentru verificarea funcţionării circuitului de înmulţire, se va lansa în execuţie programul
StateBench şi se va utiliza mai întâi comanda Verify Behavior, iar apoi comanda Cycle. Pentru aceasta,
se execută următoarele operaţii:

1. Se lansează in execuţie programul StateBench prin selectarea butonului StateBench . În
jumătatea de jos a ecranului se va afişa fereastra programului StateBench, diagrama de stare
fiind afişată în jumătatea de sus a ecranului.

2. În fereastra programului StateBench se selectează butonul Verify Behavior . Se va des-
chide fereastra de dialog Verify Behavior.

3. În secţiunea Set initial conditions se setează valorile iniţiale ale semnalelor. Mai întâi, se se-
tează valoarea deînmulţitului din registrul RX prin execuţia unui clic dublu pe numele semna-
lului RX. Se va deschide fereastra de dialog Assign Value, în care se introduce valoarea 6, iar
apoi se selectează butonul OK. Se procedează similar pentru setarea valorii înmulţitorului din
registrul RY la 5. Se execută apoi un clic dublu pe numele semnalului START pentru setarea
acestui semnal la 1 logic.

4. În secţiunea Choose the target state se selectează starea decrem_N. Simularea va fi executată
până când se ajunge în această stare.

5. Se selectează butonul Go. Programul StateBench va executa simularea cu valorile iniţiale spe-
cificate ale semnalelor până când se ajunge în starea decrem_N. Stările care au fost parcurse
vor fi indicate pe diagrama de stare prin culoarea verde, iar starea în care s-a ajuns va fi indi-
cată prin culoarea galbenă. În fereastra cu diagramele de timp ale semnalelor se trasează forma
acestora în ciclurile de ceas 0, 1 şi 2. Se va afişa apoi fereastra de dialog Reached Target State.
Aceasta indică faptul că s-a ajuns în starea specificată, fiind posibilă selectarea unei alte stări
destinaţie sau oprirea simulării. Se selectează butonul No pentru închiderea ferestrei şi oprirea
simulării prin comanda Verify Behavior.

6. Se selectează butonul Signal Editor , prin care se va deschide fereastra de dialog cu ace-
laşi nume. În secţiunea List in simulation se selectează semnalul Q, iar apoi se selectează bu-
tonul Up de două ori pentru ca semnalul Q să fie afişat imediat sub semnalul A în fereastra di-
agramelor de timp. Astfel va fi mai simplă urmărirea rezultatului înmulţirii, rezultat care se
formează în registrele A şi Q. Se selectează butonul OK, iar în fereastra Signal Editor se se-
lectează butonul No.

7. Se continuă simularea prin comanda Cycle, activată prin selectarea butonului Cycle . Prin
această comandă, execuţia va fi simulată pe durata unei perioade de ceas, fiind posibilă urmă-
rirea parcurgerii stărilor pe diagrama de stare şi a valorii semnalelor pe diagrama de timp. Se
continuă simularea prin această comandă până când se ajunge în starea termin.

8. Se verifică valorile semnalelor (registrelor) A şi Q în starea termin. Registrul A conţine valoa-
rea 1, iar Q conţine valoarea 14 (în zecimal). Deoarece registrul A conţine partea mai semnifi-
cativă a produsului, Q conţine partea mai puţin semnificativă, iar registrele sunt de câte 4 biţi,
valoarea produsului este 1×16 + 14 = 30. Rezultatul obţinut este corect (6×5 = 30).

9. În continuare se vor modifica valorile iniţiale ale registrelor RX şi RY pentru a se verifica fun-
cţionarea şi pentru alte valori ale deînmulţitului şi înmulţitorului. Pentru aceasta, se execută un
clic dublu pe valoarea 06 a semnalului RX de pe diagrama de timp, iar în fereastra Assign
Value se introduce valoarea 9 şi se selectează butonul OK. Se va afişa o fereastră de dialog, în
care se selectează butonul No pentru modificarea valorii semnalului în toate ciclurile de ceas.
Se procedează similar pentru modificarea valorii semnalului RY din 05 în 11.

10. Se introduc valorile aşteptate (cele considerate corecte) ale semnalelor A şi Q la terminarea
operaţiei (în starea termin), în scopul comparării acestor valori cu valorile obţinute la simula-
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re. Produsul aşteptat este 9×11 = 99, care se poate scrie ca 6×16 + 3. Deci, valoarea aşteptată a
semnalului A este 6, iar cea a semnalului Q este 3. Pentru setarea acestor valori, se execută mai
întâi un clic dublu pe forma de undă a semnalului A în starea termin. Se va deschide fereastra
de dialog Assertions, în care se selectează opţiunea Add pentru adăugarea valorii pe diagramă,
iar apoi se selectează butonul OK. Se va deschide fereastra de dialog Assign Value, în care se
introduce valoarea 6 şi se selectează butonul OK. Valoarea introdusă va fi marcată pe diagra-
ma de timp prin culoarea roşie. Se procedează similar pentru introducerea valorii aşteptate a
semnalului Q (valoarea 3).

11. În continuare se va reexecuta simularea cu noile valori ale semnalelor. Pentru aceasta, se se-

lectează butonul Run Test Bench . Se va afişa o fereastră de dialog, în care se selectează
butonul Yes pentru reexecutarea simulării curente cu valorile modificate ale semnalelor. Pro-
gramul StateBench va reexecuta simularea până în starea termin, verificând valorile semna-
lelor A şi Q. Se va afişa un mesaj de avertizare indicând faptul că au fost detectate diferenţe
între valorile semnalelor (“Warning: Failing assertions found...”). Se închide fereastra mesa-
jului de avertizare. Zona în care au fost detectate diferenţe între valorile semnalelor este mar-
cată pe diagrama de timp (Figura 9.26). Se execută un clic pe diagrama de timp, observând că
valoarea incorectă (indicată prin culoarea roşie) este cea a semnalului A.

Figura 9.26. Diagramă de timp indicând diferenţe între valorile aşteptate ale semnalelor şi cele obţinute la
simulare.

2.10.14. Detectarea şi corectarea erorii

Pentru detectarea erorii existente, se va utiliza comanda Find Event. La execuţia acestei co-
menzi, programul StateBench parcurge diagrama de timp şi permite oprirea la o anumită stare, la un
anumit timp de simulare, la detectarea unei diferenţe între valorile aşteptate şi cele obţinute ale sem-
nalelor, sau atunci când o expresie este adevărată. La detectarea unei condiţii specificate, programul
StateBench permite identificarea sursei semnalului şi editarea acesteia direct pe diagrama de stare.

Pentru a încerca detectarea erorii, se execută următoarele operaţii:

1. Se execută comanda Find Event prin selectarea butonului Find Event . Se va deschide fe-
reastra de dialog Find Event.

2. În această fereastră, se selectează opţiunea Find driver for output. În caseta alăturată se selec-
tează semnalul A pentru care s-a detectat diferenţa între valoarea aşteptată şi cea obţinută
(acest semnal poate fi selectat în mod automat). Se selectează apoi butonul Find Next. Se va
afişa fereastra de dialog Find, în care se indică faptul că semnalul A este setat în starea
deplas_AQ. Se selectează butonul Yes pentru editarea acestei stări pe diagrama de stare.

3. În fereastra Edit State se verifică ecuaţia registrului de deplasare A: A = A3:A3..A1. Această
ecuaţie indică faptul că, la deplasarea la dreapta a registrului, bitul cel mai semnificativ nu este
modificat. În mod normal, la deplasarea la dreapta a unui număr fără semn trebuie să se intro-
ducă valoarea 0 în poziţia cea mai semnificativă.

4. Se corectează ecuaţia registrului de deplasare, astfel: A = 0:A3..A1. Se selectează apoi buto-
nul OK.

5. În mod automat, programul StateBench va executa din nou simularea curentă, verificând valo-
rile semnalelor. Se va afişa un mesaj care indică trecerea cu succes a testelor efectuate (“All
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assertions pass.”). Se închide fereastra acestui mesaj. Se observă afişarea valorilor aşteptate
ale semnalelor cu culoarea verde.

6. Se elimină valorile aşteptate ale semnalelor prin comanda Options → Clear Assertions. Se in-
troduc alte valori în registrele RX şi RY, se setează valorile aşteptate ale semnalelor A şi Q, du-
pă care se execută din nou simularea.

7. Se salvează bancul de test prin selectarea butonului Save Test Bench . Se va deschide fe-
reastra de dialog Save Test Bench/Regression. În această fereastră se păstrează numele impli-
cite ale fişierelor şi se selectează butonul Save. Bancul de test generat în limbajul VHDL va fi
afişat în fereastra StateCAD HDL Browser. Se vizualizează codul generat, după care se închi-
de fereastra.

3. Desfăşurarea lucrării

3.1. Executaţi etapele descrise în secţiunea 2.10 pentru proiectarea circuitului de înmulţire prin
metoda directă.

3.2. Refaceţi exemplul de proiectare descris în secţiunea 2.10 pentru un circuit de înmulţire a
două numere cu semn reprezentate în complement faţă de 2 prin metoda Booth. Numerele sunt de câte
5 biţi, din care unul este bitul de semn. Desenaţi mai întâi diagrama de stare a circuitului pe hârtie, du-
pă care parcurgeţi aceleaşi etape ca şi în exemplul de proiectare descris în lucrare.

3.3. Proiectaţi circuitul de înmulţire prin metoda directă utilizând o schemă pentru partea de
prelucrare şi o diagramă de stare pentru unitatea de comandă. Intrările circuitului sunt următoarele:

• CLK: Semnal de ceas;
• RST: Semnal de resetare asincronă;
• START: Semnal pentru începerea operaţiei de înmulţire;
• X: Vector de 4 biţi care conţine deînmulţitul;
• Y: Vector de 4 biţi care conţine înmulţitorul.

Ieşirile circuitului sunt următoarele:

• A: Vector de 4 biţi care va conţine partea c.m.s. a produsului;
• Q: Vector de 4 biţi care va conţine partea c.m.p.s. a produsului;
• TERM: Semnal care indică prin valoarea logică 1 terminarea operaţiei.

Pentru proiectarea circuitului de înmulţire, utilizaţi componentele care sunt descrise pe scurt în
continuare.

• FD4CE: Registru de 4 biţi cu resetare asincronă

Intrările de date sunt D0..D3, iar ieşirile de date sunt Q0..Q3. Dacă semnalul CLR (Clear) este
1, registrul este resetat în mod asincron, ieşirile sale devenind 0. Dacă semnalul CE (Clock
Enable) este 1, la următorul impuls de ceas se realizează încărcarea paralelă a registrului cu
datele aplicate la intrare. Dacă semnalul CE este 0, ieşirile registrului rămân neschimbate.

• SR4CLED: Registru de deplasare bidirecţional de 4 biţi cu resetare asincronă

Intrările paralele de date sunt D0..D3, iar intrările seriale de date sunt SLI (utilizată în cazul
deplasării la stânga) şi SRI (utilizată în cazul deplasării la dreapta). Ieşirile de date sunt
Q0..Q3. Dacă semnalul CLR (Clear) este 1, registrul este resetat în mod asincron, ieşirile sale
devenind 0. Dacă semnalul L (Load) este 1, la următorul impuls de ceas se realizează încărca-
rea paralelă a registrului cu datele aplicate la intrare, indiferent de starea semnalului CE. Dacă
semnalul CE (Clock Enable) este 1, la fiecare impuls de ceas se realizează deplasarea regis-
trului cu o poziţie în direcţia indicată de semnalul LEFT. Dacă semnalul LEFT este 0, deplasa-
rea se realizează la dreapta, iar dacă semnalul LEFT este 1, deplasarea se realizează la stânga.
Dacă semnalul CE este 0, ieşirile registrului rămân neschimbate.
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• ADD4: Sumator de 4 biţi

Intrările sunt cei doi operanzi care trebuie adunaţi, A0..A3, respectiv B0..B3, şi transportul de
intrare CI (Carry In). Ieşirile sunt suma S0..S3, transportul de ieşire CO (Carry Out) şi sem-
nalul de depăşire OFL (Overflow). Acesta din urmă se utilizează numai la adunarea numerelor
cu semn.

• CB4CLED: Numărător bidirecţional de 4 biţi cu încărcare paralelă şi resetare asincronă

Intrările de date sunt D0..D3, iar ieşirile de date sunt Q0..Q3. Dacă semnalul CLR (Clear) este
1, numărătorul este resetat în mod asincron, ieşirile sale devenind 0. Dacă semnalul L (Load)
este 1, la următorul impuls de ceas se realizează încărcarea paralelă a numărătorului cu datele
aplicate la intrare, indiferent de starea semnalului CE. Dacă semnalul CE (Clock Enable) este
1, la fiecare impuls de ceas se realizează incrementarea sau decrementarea numărătorului cu 1,
în funcţie de semnalul UP. Dacă semnalul UP este 1, numărătorul este incrementat, iar dacă
semnalul UP este 0, numărătorul este decrementat. Dacă semnalul CE este 0, ieşirile numără-
torului rămân neschimbate. Dacă numărarea se realizează în sus, semnalul TC (Terminal
Count) devine 1 atunci când numărătorul ajunge la valoarea 1111, iar dacă numărarea se reali-
zează în jos, semnalul TC devine 1 atunci când numărătorul ajunge la valoarea 0000.

Pentru proiectarea circuitului de înmulţire, procedaţi astfel:

1. Pe baza operaţiilor elementare care trebuie realizate în fiecare etapă (operaţii descrise în secţi-
unea 2.10.1) şi a descrierii componentelor utilizate, definiţi semnalele de comandă necesare.
De exemplu, pentru validarea operaţiilor executate în etapa de iniţializare trebuie activat un
semnal de comandă numit, de exemplu, LDINIT. Acest semnal validează iniţializarea regis-
trului acumulator A cu 0 (resetarea acestuia), încărcarea deînmulţitului X în registrul B, încăr-
carea înmulţitorului Y în registrul Q şi iniţializarea numărătorului N cu 4. Alte semnale de co-
mandă sunt necesare pentru încărcarea registrului A cu valoarea de la ieşirea sumatorului,
pentru decrementarea numărătorului N şi pentru deplasarea la dreapta a registrelor A şi Q.

2. Creaţi un nou proiect, iar apoi creaţi un fişier pentru schema circuitului de înmulţire şi editaţi
schema. Plasaţi mai întâi componentele necesare în cadrul schemei, iar apoi realizaţi interco-
nectarea lor în mod asemănător cu schema din Figura 9.21 (registrele RX şi RY nu sunt utili-
zate în proiectul de faţă). Conectaţi apoi în mod corespunzător intrările de control ale compo-
nentelor, cu excepţia acelor intrări la care trebuie conectate semnalele de comandă definite
anterior. Aceste semnale vor fi conectate ulterior. Salvaţi schema circuitului.

3. Creaţi un fişier pentru diagrama de stare a unităţii de comandă. Editaţi diagrama cu ajutorul
programului StateCAD; forma diagramei poate fi cea din Figura 9.22. Specificaţi condiţiile
pentru tranziţii cu ajutorul semnalelor START, Q0 (bitul 0 al registrului Q) şi NZ (semnal care
va fi activat atunci când numărătorul N ajunge la zero). Specificaţi apoi semnalele de comandă
care trebuie activate în fiecare stare. Compilaţi diagrama pentru a crea un fişier sursă VHDL şi
închideţi programul StateCAD.

4. În fereastra Project Navigator includeţi în proiect fişierul cu diagrama de stare şi fişierul
VHDL creat pe baza diagramei. Creaţi apoi un simbol din fişierul VHDL prin selectarea
acestui fişier şi execuţia comenzii Create Schematic Symbol.

5. Deschideţi din nou fişierul cu schema şi plasaţi în cadrul schemei simbolul creat anterior, care
reprezintă unitatea de comandă a circuitului. Conectaţi intrările şi ieşirile acestei unităţi, după
care definiţi porturile de I/E ale circuitului de înmulţire.

6. Creaţi un banc de test pentru circuitul de înmulţire utilizând programul HDL Bencher.

7. Simulaţi funcţionarea circuitului de înmulţire cu simulatorul ModelSim.
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